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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the 
use or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., 
is prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

 
WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal 
injury or death, property damage, or economic loss. 

 

 
ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

 
IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

 
SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

 

 
BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures. 

 

 
ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will 
cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for 
Personal Protective Equipment (PPE). 
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Chapter 1 

Introduction 

About FactoryTalk AssetCentre 
FactoryTalk® AssetCentre monitors your factory automation system and provides centralized tools to minimize 
downtime due to unauthorized actions or failing devices. It does this by: 

• Providing version control and archiving of program files and documents. 
• Providing a disaster recovery system that verifies your devices' program and configuration files against 

protected master files, ensuring quick and accurate recovery if a problem should occur (optional Disaster 
Recovery capability). 

• Monitoring FactoryTalk-enabled software products and logging system events and user actions (recorded in 
the Event log and Audit log respectively). 

• Managing device configuration files. 

FactoryTalk Services Platform 
FactoryTalk AssetCentre uses the FactoryTalk Services Platform to provide seamless connectivity with other 
FactoryTalk-enabled software. Users and computers are defined in the FactoryTalk Directory; access to actions 
within the FactoryTalk AssetCentre system is controlled with FactoryTalk Security. 

About the documentation set 
The documentation set includes: 

• FactoryTalk AssetCentre Installation Guide (Document ID FTAC-IN005). Use this manual to install the 
FactoryTalk AssetCentre system. This manual is also available on the FactoryTalk AssetCentre installation 
package in 11.00.00-FTAssetCentre\Docs. The file name is FTAC-InstallGuide.pdf. You can find it in Rockwell 
Automation Literature Library. 

• Help. Use the comprehensive Help for assistance while using the FactoryTalk AssetCentre system. 
• FactoryTalk AssetCentre Getting Results Guide (Document ID FTAC-GR002). Use this manual to get started 

with the FactoryTalk AssetCentre system. You can find it in Rockwell Automation Literature Library. 
• FactoryTalk AssetCentre Utilities User Manual (Document ID FTAC-UM001). Use this manual for assistance 

while using an array of utilities whose capabilities are not present in the FactoryTalk AssetCentre system. 
You can find it in Rockwell Automation Literature Library. 

https://www.rockwellautomation.com/global/literature-library/overview.page
https://www.rockwellautomation.com/global/literature-library/overview.page
https://www.rockwellautomation.com/global/literature-library/overview.page
https://www.rockwellautomation.com/global/literature-library/overview.page
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About this book 
This book is written for FactoryTalk AssetCentre administrators and IT professionals. To perform many of the tasks 
described in this book, you need to log on to the computers onto which you are installing software as an 
Administrator, or log on using an account that has administrative privileges. 

We assume you are familiar with: 

• Microsoft® Windows® operating systems including basic Windows networking and administration tasks 
• Microsoft SQL Server 
• RSLinx® Classic and FactoryTalk® Linx™ communication software 
• Rockwell Automation programming tools for programmable logic controllers 
• control networks such as DeviceNet and programmable logic controllers such as ControlLogix® processors 

The components of FactoryTalk AssetCentre 
There are four primary components of a FactoryTalk AssetCentre system: 

• FactoryTalk AssetCentre server, which controls the rest of the system and governs its operations. The server 
requires Microsoft SQL Server to function (see Server computer requirements on page 9). The SQL Server is 
typically on the same computer as the FactoryTalk AssetCentre server. The instructions in this manual are 
written for that case, although the SQL Server could be installed on a different computer. 

• FactoryTalk AssetCentre clients, which permit users to configure and use the server, view logged events, and 
perform other tasks associated with the software. The client can be installed on any computer that: 

• is capable of running the client software (see Client computer requirements on page 9). 
• is connected to the FactoryTalk AssetCentre server. 

• FactoryTalk AssetCentre Web Client, which allows users to access a FactoryTalk AssetCentre client through a 
web interface on computers and mobile devices. FactoryTalk AssetCentre Web Client supports several 
FactoryTalk AssetCentre client functions. FactoryTalk AssetCentre Web Client can be accessed on any 
computer and mobile device that: 

• is capable of running the Web Client software (See Web Client computer or device requirements on page 
12). 

• is connected to the FactoryTalk AssetCentre server. 

• FactoryTalk AssetCentre agents, which are programs that perform certain scheduled operations, such as 
Disaster Recovery and searches. Agents run independently of the server and independently from each 
other—users schedule operations and the agents perform them at the scheduled time. By spreading the 
processing load over multiple computers, FactoryTalk AssetCentre agents speed up operations. When a 
server needs a scheduled operation to begin, it tries to locate an available computer running the appropriate 
agent to perform that task. When it locates an agent to perform the task, it assigns the task to that agent. 
When the agent has completed the task, the agent reports back to the server that the task is done. 

Agents can be installed on any computer that: 

• is capable of running the agent software (see Agent computer requirements on page 11). 
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• is connected to the FactoryTalk AssetCentre server. 

 

System requirements 
FactoryTalk AssetCentre works within the system requirements of all Rockwell Automation software products.  

Hardware requirements 
• For the optimal performance of the FactoryTalk AssetCentre system, computers running FactoryTalk 

AssetCentre Server, FactoryTalk AssetCentre Client, or FactoryTalk AssetCentre Agent are recommended to 
meet or exceed the following hardware requirements. 

Type Description CPU RAM 

Operator Workstation FactoryTalk AssetCentre Client Intel® Core™ i5 Standard Power processor 4 GB 
Engineering Workstation FactoryTalk AssetCentre Client 

FactoryTalk AssetCentre Agent 
Intel Core i5 Standard Power processor 8 GB 

System Agent FactoryTalk AssetCentre Agent Intel Core i5 Standard Power processor 8 GB 
Application Server 
 

FactoryTalk AssetCentre Server 
 

Small systems: 
Intel Core i5 Standard Power processor 

8 GB 

Medium to large systems: 
Intel® Xeon® quad-core family processor 

8 GB 

• For display resolution, 1024x768 or higher resolution is required. 

Product compatibility 
FactoryTalk AssetCentre version 11.00.00 is compatible with the following Rockwell Automation products. For the 
latest information regarding software platform support, refer to Rockwell Automation Product Compatibility and 
Download Center. 

FactoryTalk AssetCentre Server 
• FactoryTalk Activation version 4.05.01 or later 

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
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• FactoryTalk Services Platform version 6.21.00 or later

FactoryTalk AssetCentre Client 
• FactoryTalk Services Platform version 6.21.00 or later
• FactoryTalk Linx version 6.21.00 or later
• RSLinx Classic Lite version 4.21 or later
• (optional) RSLogix 5 version 8.00 or later, RSLogix 500 version 8.40 or later, RSLogix 5000 version 16 or later,

Studio 5000 Logix Designer version 21 or later, FactoryTalk View Studio Enterprise version 12.00 or later, or
any other version released as part of CPR 9 or later

• To take advantage of auditing, the FactoryTalk AssetCentre client must be installed on each computer
running your RSLogix family software.

• To edit the file and data settings for a compare operation for PLC-5, SLC 500, MicroLogix, or FactoryTalk
View Site Edition assets, you must have RSLogix 5, RSLogix 500, or FactoryTalk View Studio Enterprise
software installed on the client computer.

• To do a Rockwell Automation Compare, you must install the programming software on the client
computer.
For this asset... Install... Version 

PLC-5 RSLogix 5 10.00 
SLC 500, MicroLogix RSLogix 500 12.00 
ControlLogix, CompactLogix RSLogix 5000 16 or later 

Studio 5000 Logix Designer 21 or later 
RSLogix 5000 Compare Utility or Logix 
Designer Compare Tool 

8.12 

Rockwell Automation drives DriveExecutive™ Lite 5.02 or later 

• (optional) FactoryTalk View ME Transfer Utility version 12.00 or later if your system includes PanelView Plus
and MobileView operator interfaces

• (optional) DriveExecutive Lite version 5.02 or later

FactoryTalk AssetCentre Agent 
• FactoryTalk Services Platform version 6.21.00 or later
• FactoryTalk Linx version 6.21.00 or later
• RSLinx Classic Lite version 4.21 or later
• RSLogix 5000 Compare Tool version 3.40.01.118 or later

• UDC version 4.07 or later

UDC will be installed by default as FactoryTalk AssetCentre installation

• FactoryTalk View ME Transfer Utility version 12.00 or later if your system includes PanelView Plus and 
MobileView operator interfaces

• DriveExecutive Lite version 5.02 or later
• For Disaster Recovery functions, the programming software for your devices MUST be installed on the agent 

computer. 
Asset Compatible Software Version 

PLC-5 RSLogix 5 8.00 or later 
SLC 500, MicroLogix RSLogix 500 8.40 or later 
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ControlLogix, CompactLogix Studio 5000 Logix Designer 21.00 or later 
RSLogix 5000 16.00 or later 
RSLogix 5000 Compare Utility or Logix Designer Compare Tool 8.12 

PanelView Plus, MobileView FactoryTalk View ME Transfer Utility 12.00 
FactoryTalk Linx (formerly known as RSLinx Enterprise) 6.21 

FactoryTalk View Site Edition FactoryTalk View Studio Enterprise 12.00 

Rockwell Automation drives DriveExecutive Lite 5.02 or later 
PowerFlex Drive UDC 4.07 

Operating systems 
FactoryTalk AssetCentre is tested and supported on the operating systems installed from original Microsoft media 
only. FactoryTalk AssetCentre runs on either the 32-bit or 64-bit versions of the following operating systems. 

IMPORTANT Turn off the Windows updates on production computers. Installing Microsoft Service Pack 
release or Windows operating system updates may affect the operation of Rockwell 
Automation software installed on the computer. To avoid this problem, see 
Knowledgebase Document ID: QA2151 - Microsoft Patch Qualifications. 

FactoryTalk AssetCentre Server 
This version of FactoryTalk AssetCentre Server was tested on these 64-bit operating systems: 

• Windows Server® 2019
• Windows Server 2016
• Windows Server 2012 R2

FactoryTalk AssetCentre Client and Agent 
This version of FactoryTalk AssetCentre Client and Agent were tested on these 64-bit operating systems: 

• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2
• Windows® 10 Enterprise 2019 LTSC
• Windows 10 (v1903, v1909, v2004, and v20H2)

FactoryTalk AssetCentre adopts .NET 4.8 which is only supported on Windows 10 v1803 and later.

• Windows 7 (Enterprise Edition with Service Pack 1 and Professional Edition with Service Pack 1)

FactoryTalk AssetCentre Web Client 
• For Windows Operating Systems:

Please reference the list of compatible Microsoft Windows Operating Systems list under FactoryTalk
AssetCentre Client.

• Android™ version 10
• iOS version 14.3

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/35530
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Tip: Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 
R2, it is required that you install the following Windows update: 
Windows Server 2012 R2 update: April 2014 

 

Software requirements 
FactoryTalk AssetCentre Server 
The following are minimum software requirements for FactoryTalk AssetCentre Server. 

• Microsoft® Edge™ version 80 or later 

The version 80 or later is recommended for Windows Server 2012 R2, Windows Server 2016, and Windows 
Server 2019 operating systems. 

SQL Server databases 
The following are SQL Servers supported by FactoryTalk AssetCentre. 

• Microsoft SQL Server 2019 
• Microsoft SQL Server 2017 
• Microsoft SQL Server 2016 
• Microsoft SQL Server 2014 

FactoryTalk AssetCentre Client 
The following are minimum software requirements for FactoryTalk AssetCentre Client. 

• Microsoft Edge version 80 or later 

The version 80 or later is recommended for Windows Server 2012 R2, Windows Server 2016 and Windows 
Server 2019 operating systems. 

• (optional) Editing software for Siemens S7 processors, such as SIMATIC Manager 
• It is only required when using Disaster Recovery for Siemens S7 (S7-300/400 with STEP7 software). 

FactoryTalk AssetCentre Agent 
The following are minimum software requirements for FactoryTalk AssetCentre Agent. 

• Microsoft Edge version 80 or later 

The version 80 or later is recommended for Windows Server 2012 R2, Windows Server 2016 and Windows 
Server 2019 operating systems. 

• (optional) SIMATIC NET if you want to connect to Siemens S7 processors via MPI (Multi Point Interface) or 
PROFIBUS protocol 

• It is only required when using Disaster Recovery for Siemens S7 (S7-300/400 with STEP7 software) 

FactoryTalk AssetCentre Web Client 
The following are minimum software requirements for FactoryTalk AssetCentre Web Client. 

https://support.microsoft.com/en-us/kb/2919355
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• Chrome™ browser version 87 
• Apple® Safari® version 13.0.4 
• Mozilla® Firefox® version 84 
• Edge version 87 

Network requirements 
Your Microsoft Windows network must use the TCP/IP protocol. 

If you use a firewall, you must configure the firewall to permit traffic on the following ports. 

Port type and name Comments 

TCP port 25 Standard SMTP email port 
TCP port 80 Standard WWW port 
TCP port 135 RPC/DCOM endpoint mapper 
TCP port 445 File and printer sharing 
TCP port 1433 Communications to SQL Server 
TCP port 2222 Source port for connections 
TCP port 4241 FactoryTalk Live Data Message for FactoryTalk Linx 

(RSLinxNG.exe) 
TCP port 5241 FactoryTalk Application Services 
TCP ports 7002 - 7004 FactoryTalk AssetCentre 
UDP port 137 File and printer sharing 
UDP port 138 File and printer sharing 
UDP port 1434 Browsing for SQL Servers 
UDP port 21060 Rockwell Automation Trace Diagnostics 
UDP port 21061 Rockwell Automation Trace Diagnostics 
TCP/UDP 44818 Ethernet/IP, messaging, data transfer, or peer messaging 

Some of these ports may vary on your network. Work with your network administrators to determine the correct 
port numbers to open. 

IMPORTANT TCP port 445 can be turned off in the computers with FactoryTalk AssetCentre system or 
its components. If using Disaster Recovery for Remote Computer, the remote computer 
with the shared folder must have TCP port 445 turned on for file sharing. 

You may need to open ports for other Rockwell Automation products as well. See Knowledgebase Document ID: 
BF7490 - TCP/UDP Ports Used by Rockwell Automation Products. 

About the installation process 
FactoryTalk AssetCentre supports two installation methods: 

• Setup wizard installation 
• Unattended or silent installation 

The Setup wizard installs the software through the installation interface step by step. If you choose the standard 
Setup wizard to install FactoryTalk AssetCentre software, Chapter 2 through Chapter 5 guides you through the 
following tasks: 

1. Install the prerequisite software for the FactoryTalk AssetCentre server. 
2. Install the FactoryTalk AssetCentre server. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/898270
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3. Install FactoryTalk AssetCentre agents. 
4. Install FactoryTalk AssetCentre clients. 

The unattended or silent installation uses command lines to specify installation properties so that the software is 
installed without user intervention. Unattended or silent installation doesn't omit any installation components 
against the standard method. It allows you to specify all installation properties before the installation starts, and 
then installs the software automatically. To install FactoryTalk AssetCentre software with silent or unattended 
installation, see Chapter 8 for detailed instructions. 
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Chapter 2 

Install the FactoryTalk AssetCentre server software 

This chapter describes: 

• Before you install the FactoryTalk AssetCentre server software on page 15 
• Steps to install the FactoryTalk AssetCentre server software on page 19 

Before you install the FactoryTalk AssetCentre server software 
The following checklist summarizes the basic tasks involved in installing FactoryTalk AssetCentre server software 
along with supporting software. 

• Ensure that the user performing installation has administrative rights in Windows. 
• Ensure that the Windows account of the user performing the installation, or a Windows group of which the 

user performing the installation is a member, is assigned the Microsoft SQL Server System Administrator 
role before attempting the installation. This change is optional for Upgrade installations. 

• Ensure that the following software or services is installed on the computer: 

• Microsoft SQL Server (can be located on a separate computer) 

• If you will configure the FactoryTalk AssetCentre server with a remote database, ensure that a Managed 
Service Account or group Managed Service Account is created on your computer that is used as a domain 
controller.  

SQL Server Authentication is also supported for convenience of upgrading from version 10.00.00 and earlier 
and for those users who know the risks. 

 
WARNING:  
• The number of failed sign-in attempts from attackers will cause a user account to be 

locked. 
• The encrypted SQL Server Authentication login password, must be passed over the 

network at the time of the connection. Some applications that connect automatically will 
store the password at the client. These are additional attack points. 

• Windows offers additional password policies that are not available for SQL Server logins. 

• Schedule downtime for the system if you are upgrading operating applications or replacing computers 
during the installation. 

IMPORTANT If you use a software firewall (such as the Windows Firewall), refer to Network 
requirements on page 13. You must open Port 80 (or whatever port is used for 
HTTP). 

 

Ensure that the current Windows user has administrative rights 
As part of the installation process, FactoryTalk AssetCentre creates program folders and modifies registry entries. 
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For this part of the process to succeed, the user installing the software must have administrative rights in Windows 
on the computer where the software is being installed. 

For example, the Windows domain Administrator account has these rights and will be able to install FactoryTalk 
AssetCentre software. 

Install Microsoft SQL Server 
FactoryTalk AssetCentre uses a Microsoft SQL Server database to store project files and user data. You may install 
SQL Server on the FactoryTalk AssetCentre server computer or on a separate server computer. Microsoft SQL Server 
is not included in FactoryTalk AssetCentre installation package. You need to purchase Microsoft SQL Server 
separately. 

 
Tip: Before you install Microsoft SQL Server, you need to turn off Windows Firewall from Windows Control 
Panel. 

If a supported edition of SQL Server is installed, you can skip these steps, however, you may need to reconfigure the 
SQL Server. 

To install Microsoft SQL Server 
1. Log on to the server computer as an administrator or as a user with administrative rights. 

 
Tip: It is possible to install the SQL Server on a different computer from the one on which you 
install the FactoryTalk AssetCentre server software. 

2. Start the SQL Server installation from the SQL Server media. 
3. Follow the on-screen instructions for installation until you get to the Feature Selection screen. 
4. On the Feature Selection screen, choose the SQL Server features that you want to install. If you like, or if your 

business requires you to do so, you may install the complete SQL Server installation. 

If you want to install only those features necessary to run the FactoryTalk AssetCentre server: 

a. On the Feature Selection screen, make sure the following features are selected: 

• Database Engine Services 
• Full-Text and Semantic Extractions for Search 
• Client Tools Connectivity 
• Client Tools Backwards Compatibility 
• Management Tools - Basic (not applicable for Microsoft SQL Server 2016 or Microsoft SQL Server 2017) 

b. Click Next. 

5. Follow the on-screen instructions for installation until you get to the Server Configuration screen. 
6. In the Server Configuration screen, the Services Accounts tab asks how you want to run the services for the 

SQL Server. Specify the account name and password for each SQL Server service. 

 
Tip: You can run the SQL Server using a domain account. This can, however, complicate system 
maintenance (for instance, when changing passwords). If you are not sure of the type of 
account you should use for running the SQL Server, consult your network administrator. 

7. In the Server Configuration screen, click the Collation tab. 
8. Under Database Engine, make sure that SQL_Latin1_General_CP1_CI_AS is selected (it is the default 

setting). 
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If it isn't, click Customize, and then, in the Customize the SQL Server Version Database Engine Collation 
dialog box (where version is your SQL Server version), select SQL collation, used for backwards compatibility 
and SQL_Latin1_General_CP1_CI_AS. 

IMPORTANT The collation settings must be case-insensitive! If the settings are case-sensitive, 
the FactoryTalk AssetCentre database installation will fail. 

9. In the Database Engine Configuration window, click the Server Configuration tab.
10. Under Authentication Mode, select Windows Authentication.

If you want to access the database with SQL Server Authentication in the future, select Mixed Mode (SQL
Server Authentication and Windows Authentication).

WARNING: 
• The number of failed sign-in attempts from attackers will cause a user account to be 

locked. 
• The encrypted SQL Server Authentication login password, must be passed over the 

network at the time of the connection. Some applications that connect automatically will 
store the password at the client. These are additional attack points. 

• Windows offers additional password policies that are not available for SQL Server logins. 

When you select Mixed Mode, fields open for entering the password for the sa (SQL Server system 
administrator) account password. Do not forget the password. You will need this password when you install 
the FactoryTalk AssetCentre server. 

IMPORTANT Do not leave the password blank. Doing so leaves your SQL Server and your 
computer open to attack. 

11. Follow the on-screen instructions to complete the installation.

After you install a Microsoft SQL Server, you must install an appropriate service pack, which is necessary for the 
software to run properly and protects your SQL Server from certain types of attacks. 

Tip: It is recommended to install Microsoft SQL Servers with their latest Service Pack. 

Minimum Microsoft SQL Server permissions 
The permissions discussed here are set automatically during the FactoryTalk AssetCentre Database installation. The 
information is provided for reference for the SQL administrator. 

The Microsoft service accounts (virtual account, MSA, and gMSA) user's default database value can be master or 
AssetCentre. By default, the database value is set to AssetCentre. The Microsoft service accounts (virtual account, 
MSA, and gMSA) user needs to belong to the following AssetCentre database roles: 

• db_dataexecute
• db_datareader
• db_datawriter
• public

The db_dataexecute database role was added to the FactoryTalk AssetCentre database during the FactoryTalk 
AssetCentre server installation. It is used to group Execute permissions of stored procedures and functions within 
the AssetCentre database. 
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All of the user stored procedures and user functions in the FactoryTalk AssetCentre database need to have the 
Execute permission granted to the db_dataexecute database role. 

Create and install a Managed Service Account or group Managed Service Account 
FactoryTalk AssetCentre version 11.00.00 supports Managed Service Account (MSA) and group Managed Service 
Account (gMSA) that provide automatic password management, simplified service principal name (SPN) 
management, and the ability to delegate the management to other administrators.  

Prerequisites 
Make sure that: 

• Your operating system is Windows Server 2012 R2 (patched with KB2998082) or later.
• Your SQL server is SQL Server 2014 or later.
• You have Active Directory module for Windows PowerShell installed on your computer.

To create and install an MSA 
1. On the domain controller computer, open the Windows PowerShell window.
2. To verify that the Key Distribution Service (KDS) Root Key for your domain controller is installed on your

computer, enter Test-KdsRootKey -KeyId (Get-KdsRootKey).KeyId.

If the returned value is True, it means that KDS Root Key is already installed.
If the returned value is False, it means that there is no valid KDS Root Key. To add a KDS Root Key, enter Add-
KdsRootKey -EffectiveImmediately.

Note: It may take up to 10 hours to implement the function of the KDS Root Key. 

3. To create an MSA, enter New-ADServiceAccount -Name <msa01> -Enabled:$true -Description "Manage Service
Account for FTAC" -DisplayName <msa01> -RestrictToSingleComputer

Note: 
• The "<>" means it is a variable. You can customize the name as needed. 
• Quotes are required for the name with space. For example, "msa 01".

4. On the FactoryTalk AssetCentre server computer, open the Windows PowerShell window, and then enter
Install-WindowsFeature RSAT-AD-PowerShell -ComputerName <winsql-01> to install the Active Directory
PowerShell module.

Note: The "<>" means it is a variable. That is the name of FactoryTalk AssetCentre server 
computer on which you will install the MSA. 

5. To install the MSA, enter Install-ADServiceAccount -Identity <msa01>.
6. To test the MSA, enter Test-ADServiceAccount -Identity <msa01>.

An MSA is only allowed to use on one computer. If you want to use it on another computer, enter UnInstall-
ADServiceAccount -Identity <msa01>, and then install it on the computer as needed.

To create and install a gMSA 
1. On the domain controller computer, open the Windows PowerShell window.
2. To verify that the Key Distribution Service (KDS) Root Key for your domain controller is installed on your

computer, enter Test-KdsRootKey -KeyId (Get-KdsRootKey).KeyId.



 

 Rockwell Automation Publication - FTAC-IN005I-EN-E - March 2021 19 
 

If the returned value is True, it means that KDS Root Key is already installed. 
If the returned value is False, it means that there is no valid KDS Root Key. To add a KDS Root Key, enter Add-
KdsRootKey -EffectiveImmediately. 

 
Note: It may take up to 10 hours to implement the function of the KDS Root Key. 

3. To create an Active Directory (AD) Security Group, enter New-ADGroup -Name <gsg_gmsa01> -Description 
"Security group for <gmsa01> computers" -GroupCategory Security -GroupScope Global. 

 
Note:  
• The "<>" means it is a variable. You can customize the name as needed. 
• Quotes are required for the name with space. For example, "gmsa 01". 

4. To add computer objects to the AD Security group, enter Add-ADGroupMember -Identity <gsg_gmsa01> -
Members <winsql-0$>, <winsql-01$>. 

 
Note: When adding the computer objects, it is required to add "$" after the computer account 
name and restart the computer. 

5. To create a gMSA, enter New-ADServiceAccount -Name <gmsa01> -PrincipalsAllowedToRetrieveManagedPassword 
<gsg_gmsa01> -Enabled:$true -DNSHostName ServerD.astest.com. 

6. On the FactoryTalk AssetCentre server computer, enter Test-ADServiceAccount -Identity <gmsa01> to test the 
gMSA. 

Steps to install the FactoryTalk AssetCentre server software 
The Setup wizard installation process includes the following steps: 

• Step 1: Launch the Setup wizard and select what to install on page 19 
• Step 2: Configure the AssetCentre server on page 20 
• Step 3: Read and accept license agreements on page 21 
• Step 4: Start the installation on page 21 
• Step 5: Finish the installation on page 21 

Step 1: Launch the Setup wizard and select what to install 
Before starting th installation of FactoryTalk AssetCentre server, you should ensure: 

• You select the Windows Authentication, when you install Microsoft SQL Server. 
IMPORTANT • If you select Mixed Mode when installing Microsoft SQL Server, you can use SQL 

Server Authentication to access remote database. 
• When using SQL Server Authentication, you must use silent or unattended setup 

to install FactoryTalk AssetCentre version 11.00.00 or later. 

• When SQL Server and FactoryTalk AssetCentre server are co-located, the system will automatically use a 
Windows virtual account. 

• A Managed Service Account (MSA) or group Managed Service Account (gMSA) is required when the SQL 
Server is remote from the FactoryTalk AssetCentre sever. 

• Windows local user account, Windows Active Directory (AD) user account or a Windows AD group where 
your user account is a member has been assigned SQL Server system administrator role. 

When installing FactoryTalk AssetCentre server, you can follow the steps as below: 
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Note: When installing FactoryTalk AssetCentre server and SQL Server database on the same computer, 
you can use a local Windows user account or an AD user account. 
When you install FactoryTalk AssetCentre server and SQL Server database on different computers, only 
an AD user account is available. 

1. Log on to your server computer as an administrator, or as a user with administrative privileges. 
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD 

in the computer's DVD drive. 
3. Run D:\setup.exe, where D:\ is the drive containing the DVD. 
4. Select AssetCentre Server. 

 
Tip: To install AssetCentre Server, AssetCentre Client, and AssetCentre Agent at the same 
time, select AssetCentre Custom Installation. Custom installation allows you to install more 
than one or all of the installation components. 

5. Select Customize. 
6. On the Customize page: 

• To install web service for FactoryTalk Security, expand FactoryTalk Services Platform v6.21.00 and select 
FactoryTalk Security Web Service. 

• If no other FactoryTalk-enabled software of the computer needs FactoryTalk Linx, expand FactoryTalk 
Services Platform v6.21.00, clear FactoryTalk Linx v6.21.00. 

• If no other FactoryTalk-enabled software of the computer needs FactoryTalk Activation Manager, clear 
FactoryTalk Activation Manager v4.05.01. 

• To install the FactoryTalk Updater utility, expand Tools and then select FactoryTalk Updater Agent 
v2.00.00. It assists management of installed Rockwell Automation software by announcing new versions 
and patch roll-ups. Registering for updates is not required to receive announcements from the 
FactoryTalk Updater. 

7. Select the location for the software. The default location is C:\. 
8. Select Next. 

Step 2: Configure the FactoryTalk AssetCentre server 
The FactoryTalk AssetCentre server can be configured with local database or remote database. 

To configure the FactoryTalk AssetCentre server with a local database 
1. In the Database Server box, the default name of the local database server is (local). 
2. Select Next. 
3. On the Configure AssetCentre Server database page, select Next. 

 
Note: The database will be configured with a Windows virtual account automatically. 

4. Make sure the check box of Secure communication with SSL/TLS is selected to turn on HTTPS. 

 
WARNING: HTTPS is generally recommended to turn on. To use HTTPS, you must configure 
SSL or TLS certificate after installing FactoryTalk AssetCentre. 
If you don't want use HTTPS, clear the Secure communication with SSL/TLS check box. 
The potential risks of turning off HTTPS are as below: 
• The data is transmitted without encryption across a network, which will cause leakage of 

information, if other solutions, such as IPSEC, are not used. 
• The system may be vulnerable to a Remote Code Execution (RCE) attack. 

5. Select Install. 
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To configure the FactoryTalk AssetCentre server with a remote database. 
1. In the Database server box, enter the name of a remote database server, or in the Location list, choose the 

location of the remote database server you ever used. 
2. Select Next. 
3. In the Account Name box, enter the name of an MSA or gMSA, or select Add to add an account. 

IMPORTANT • Ensure that you are in the correct domain. 
• The valid format of an account name is domain name\object name. 

4. Select Next. 
5. Make sure the check box of Secure communication with SSL/TLS is selected to turn on HTTPS. 

 
WARNING: HTTPS is generally recommended to turn on. To use HTTPS, you must configure 
SSL or TLS certificate after installing FactoryTalk AssetCentre.  
If you don't want use HTTPS, clear the Secure communication with SSL/TLS check box. 
The potential risks of turning off HTTPS are as below: 
• The data is transmitted without encryption across a network, which will cause leakage of 

information, if other solutions, such as IPSEC, are not used. 
• The system may be vulnerable to a Remote Code Execution (RCE) attack. 

6. Select Install. 

Step 3: Read and accept license agreements 
End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being 
installed, there may be more than one license agreement on this page. The individual license agreements are listed 
above the text box. 

Some software products may be delivered or made available only after you agree to the terms and conditions of each 
of the license agreements. 

1. On the End User License Agreements page, select each agreement and read the agreement carefully. 
2. When all license agreements have been read, select Accept All. 

Step 4: Start the installation 
After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software 
applications selected previously. No further user input is required. 

Step 5: Finish the installation 
After the installation completes, you need to activate the software for its full feature capabilities. You can activate the 
software now or later. 

• To activate the installed software, select Activate your software, and then select Next. 

The Software Activation dialog box opens. 

a. In the Serial number box, enter the serial number. 

b. In the Product key box, enter the product key. 

c. Select the earliest version you will use. 
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d. Select Activate locally or Activate using a dongle. 

e. Click Continue. 

You will be prompted to restart the computer after the activation. 

• To finish the installation without activation, select Skip activation, and then select Next. 

• To view the installation details, select Installation Summary. 
• To receive the latest product updates and patch notification, select Register for updates. 
• To install the latest version of Adobe® Acrobat® Reader®, select Download it free and follow the on-screen 

instructions. 

Restart the computer to complete the installation. 

When the installation is finished, it is recommended that you: 

• Configure the SSL protocol. 

If you have HTTPS turned on during installing FactoryTalk AssetCentre, you must Configure the SSL 
protocol for FactoryTalk AssetCentre on page 73. 

• Install the latest FactoryTalk AssetCentre patches. 

See Knowledgebase Document ID: QA15600 - FactoryTalk AssetCentre Patch Roll-up for 3.0 and later. 

For FactoryTalk AssetCentre version 8.00 and earlier, the repair function executes the same workflow which 
PlantPax team uses. Since version 9.00, FactoryTalk AssetCentre starts to use the silent repair of the common install. 
You cannot change the FactoryTalk AssetCentre SQL server instance during repair progress. If you need to change 
the FactoryTalk AssetCentre SQL server instance after installing the FactoryTalk AssetCentre server software, you 
can follow the steps as below: 

1. Install FactoryTalk AssetCentre server, client, agent, and SQL Express on a single Server 2016 instance. 
2. Install SQL Server 2016 on a separated computer. 
3. On the FactoryTalk AssetCentre server computer, run the utility FTAssetCentre.DbInstaller.exe in 

C:\Program Files (x86)\Rockwell Software\AssetCentre Server\Bin\RockwellAutomation, and then enter their 
SQL information which is on the separated computer. 

4. Then run FTAssetCentre.AosCatalogImport.exe in C:\Program Files (x86)\Rockwell Software\AssetCentre 
Server\Bin\ RockwellAutomation. 

5. Restart FactoryTalk AssetCentre server computer. At this time, the FactoryTalk AssetCentre server has 
pointed to the new SQL DB server. The FactoryTalk AssetCentre server, agent, and client are working 
normally with new FactoryTalk AssetCentre SQL server instance. 

 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/473892
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Chapter 3 

Install FactoryTalk AssetCentre agents 

This chapter describes: 

• Before you install the FactoryTalk AssetCentre agent software on page 23 
• Steps to install the FactoryTalk AssetCentre agent software on page 25 
• Configure for security-enabled RSLogix family software on page 29 
• Check whether the agent software is current on page 30 

Before you install the FactoryTalk AssetCentre agent software 
Agents are programs that communicate with the FactoryTalk AssetCentre server and perform scheduled tasks on 
behalf of the FactoryTalk AssetCentre server. Agents allow work to be distributed and shared among multiple 
computers to spread processing load and speed up operations. When a server needs an agent to perform a task, it 
locates the computer running the operation and assigns the task to that agent. The agent then reports the task’s 
completion to the server. The Search feature, as well as purchased capabilities, such as Disaster Recovery 
capabilities, require the use of agents to perform scheduled operations. 

 
Tip: Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 R2, it is 
required that you install the following Windows update: 
Windows Server 2012 R2 update: April 2014 

Where to install the FactoryTalk AssetCentre agent software 
Agents can be installed on any computer that: 

• Is capable of running the agent software (see Agent computer requirements on page 11). 
• Is connected to the FactoryTalk AssetCentre Server. 
• Runs the FactoryTalk AssetCentre server, or the FactoryTalk AssetCentre client. 

The amount of clients, agents, and agent groups qualified within one FactoryTalk AssetCentre system 
The following is the amount of clients, agents, and agent groups qualified within one FactoryTalk AssetCentre 
system at the same time. More clients, agents, or agent groups running will impact the system performance. 

• Client: 150 
• Agent: 50 
• Agent groups: 50 
• Agent computers in each agent group: 5 

If scheduled operations are taking longer than desired to complete, you may need install more Disaster Recovery 
agents. To estimate the number of necessary FactoryTalk AssetCentre agents in your system, see Knowledgebase 
Document ID: IN29429 - Determining the Necessary Number of FactoryTalk AssetCentre Agents. 

https://support.microsoft.com/en-us/kb/2919355
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/106118
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You can use the Agent Controller Launch Control Panel to start the agent controller application automatically 
following a reboot of the computer. To do so, you must turn off User Account Control on the operating system. 

If your system uses PanelView Plus operator interfaces, you must install FactoryTalk Linx (formerly known as 
RSLinx Enterprise), and the FactoryTalk View ME Transfer Utility software on every agent computer in the system. 
FactoryTalk Linx (formerly RSLinx Enterprise) must be version 5.00 or later. FactoryTalk View ME Transfer Utility is 
a separate installation. The installation is included on the FactoryTalk AssetCentre installation DVD in 12.00.00-
FTView\Tools\ME Transfer Utility\FactoryTalk View ME Transfer Utility.msi. 

Also, for Disaster Recovery functions, the agent computer MUST have the appropriate RSLogix family software for 
your devices. 

Enable .NET Framework 3.5 features 
You need to manually install .NET Framework 3.5 SP1 before installing the FactoryTalk AssetCentre agent, if you are 
using Logix Designer Compare Tool on one of the following operating systems: 

• Windows Server 2019 
• Windows Server 2016 
• Windows Server 2012 R2 

 
Tip: To enable the .NET Framework features, you need to log on to the computer as an 
administrator or a user with administrative privileges. 

To install .NET Framework 3.5 SP1 
• If you have an Internet connection, install .NET Framework 3.5 SP1 via Control Panel. Learn how at 

http://msdn.microsoft.com/en-us/library/hh506443.aspx. 
• If you do not have an Internet connection, install .NET Framework 3.5 SP1 with DISM (Deployment Image 

Servicing and Management) command-line tool. You need the original Windows installation DVD and 
administrative rights in the operating system. Perform the following steps. 

1. Insert the Windows installation DVD. 
2. Open a Command Prompt window with administrative credentials (that is, click Search in the charms bar, 

type CMD in the search box; in the searching results, right-click the Command Prompt icon, and choose 
Run as administrator.) 

3. In the Command Prompt window, type the following command, and then press Enter: 
DISM /Online /Enable-Feature /FeatureName:NetFx3 /All /LimitAccess 
/Source:E:\sources\sxs 

 
Tip: In the command, the /Source: specifies the location of the files needed for the .NET 
Framework 3.5 SP1 installation. You need to specify this location according to the path 
to your Windows installation DVD. In this example, the location is E:\sources\sxs. When 
the installation is completed, the following message shows in the Command Prompt 
window: "The operation completed successfully. 

For more information on installing .NET 3.5 SP1, including tips on troubleshooting problems, visit: 

• http://msdn.microsoft.com/en-us/library/hh506443.aspx 
• http://support.microsoft.com/kb/2734782 

http://msdn.microsoft.com/en-us/library/hh506443.aspx
http://msdn.microsoft.com/en-us/library/hh506443.aspx
http://support.microsoft.com/kb/2734782
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Steps to install the FactoryTalk AssetCentre agent software 
The Setup wizard installation process includes the following steps: 

• Step 1: Launch the Setup wizard and select what to install on page 25 
• Step 2: Read and accept license agreements on page 29 
• Step 3: Start the installation on page 29 
• Step 4: Finish the installation on page 29 

Step 1: Launch the Setup wizard and select what to install 
You must have the appropriate RSLogix family software for your devices installed on the agent computer to run 
Disaster Recovery schedules. 

You can install the agent using either the installation package or the FactoryTalk AssetCentre server website. 

To install a FactoryTalk AssetCentre agent using the installation package 
1. Log on to your server computer as an administrator, or as a user with administrative privileges. 
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD 

in the computer's DVD drive. 

Run D:\setup.exe, where D:\ is the drive containing the DVD. 

3. Select AssetCentre Agent. 

 
Tip: To install AssetCentre Server, AssetCentre Client, and AssetCentre Agent at the same time, 
select AssetCentre Custom Installation. Custom installation allows you to install more than 
one or all of the installation components. 

4. To install all components available in the selected software using the recommended settings, click Install 
now and skip to Step 2: Read and accept license agreements on page 29. 

5. To select which components to install, click Customize. 
6. On the Customize page: 

• To install web service for FactoryTalk Security, expand FactoryTalk Services Platform v6.21.00 and select 
FactoryTalk Security Web Service. 

• To register EDS files from devices to allow device communications in the Network Browser, expand 
FactoryTalk Services Platform v6.21.00, expand FactoryTalk Linx v6.21.00, and then select Register EDS 
Files. If you are running out of storage, clear this check box. However, clearing this check box turns off the 
EDS Parameter shortcut function. 

• To enable security for Rockwell Software security clients, expand RSLinx Classic v4.21.00 and select 
Enable Security. 

• To install the additional software, expand Tools to select the following software: 

• Logix Designer Compare Tool v8.12.00 
• RSLogix 5 v10.00.00 
• RSLogix 500 v12.00.00 
• FactoryTalk View ME Transfer Utility v12.00.00 
• FactoryTalk Updater Agent v2.00.00 

7. Select the location for the software. The default location is C:\. 
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8. Select Next. 
9. In the Security options box, select the options for RSLogix 5 as needed. If you do not want to use FactoryTalk 

Security, clear the Enable FactoryTalk® Security check box. 

 
Note: For more information about the RSLogix 5 installation, refer to RSLogix 5 Getting Results 
Guide. 

10. Click Next. 
11. In the Security options box, select the options for RSLogix 500 as needed. If you do not want to use 

FactoryTalk Security, clear the Enable FactoryTalk® Security check box. 

 
Note: For more information about the RSLogix 500 installation, refer to RSLogix 500 Getting 
Results Guide. 

12. Select Install. 

To install a FactoryTalk AssetCentre agent using the FactoryTalk AssetCentre server website 
1. Open Internet Explorer, and in the Address box, type the following: 

http://servername/rockwellsoftware/assetcentre 
where servername is the name of your FactoryTalk AssetCentre server computer. 
For example, if your FactoryTalk AssetCentre server computer name is MYSERVER, type the following: 
http://MYSERVER/rockwellsoftware/assetcentre 

 
Tip:  
• If you are using SSL, then start the address with https:// instead of http://. 
• If you have changed the default port in site binding on page 77, you need to include the self-

defined port number in the computer name part in the form as MYSERVER:PortNumber. 
• If you install the FactoryTalk AssetCentre agent software on the FactoryTalk AssetCentre 

server computer, type the following in the Address box: 
http://localhost/rockwellsoftware/assetcentre 

2. Press Enter. 

Internet Explorer shows a page from the server that allows you to install the FactoryTalk AssetCentre client 
software. 

3. Click Install AssetCentre Agent on this computer. 

The installation automatically starts when the installation package is downloaded. 

 
Tip: If Internet Explorer shows an error message that it cannot connect to the install web page, 
try bypassing the proxy for local addresses. Also make sure that IIS is running on the server. For 
information on running IIS see Web page for installing the FactoryTalk AssetCentre client and 
agent cannot be shown on page 112. 
If in one of the following situations: 
• Internet Explorer shows a warning about opening possibly unsafe content or downloading 

possibly unsafe files 
• Windows SmartScreen prevents the installation 
Add the FactoryTalk AssetCentre Web site (URL above) to your Trusted Sites. See your Internet 
Explorer documentation for more information. 
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If operating in a Windows domain 
1. Create a domain account for the VerificationAgent service and the FactoryTalk AssetCentre 

AgentController service to run as. This is generally performed by someone in your Information Technology 
department. This account must be used exclusively for the service, not by users. 

2. On each agent computer: 

• Add the new domain account to the Administrator user group in Windows. 
• Configure both services to run as the new domain account created above. To do so, open the Services 

utility in Microsoft Windows, find the FactoryTalk AssetCentre AgentController service and edit its 
properties to log on as the account. Find the VerificationAgent service and edit its properties to log on as 
the account. 

3. On any computer in the system, open the FactoryTalk Administration Console (logging on to the Network 
directory using a FactoryTalk Administrator account) and add the new domain account as a new Windows-
linked user. 

4. Grant this user read access to the FactoryTalk Directory. To do so, right-click the Network node at the top of 
the tree, and then select Security. On the Permissions tab, select the domain account and then expand the 
Common permissions group. Make sure the Read permission is set to Allow. 

5. Set permissions for your RSLogix family software packages (depending on what type of processors you are 
using). Under System in the Explorer pane, right-click Networks and Devices and select Security. On the 
Permissions tab, select the new domain user. (If the user account you just created does not appear in the list 
of users, add it.) Expand the permissions group for the appropriate software and set the following 
permissions to Allow: 

• For RSLogix 5 grant Offline Program File Monitoring, Save, and Upload. 
• For RSLogix 500 grant Offline Program File Monitoring, Save, and Upload. 
• For RSLogix 5000 grant Project: Export, Project: Go Online, Project: Open, Project: Save, and Project: 

Upload. (Use this group for Logix Designer applications and grant the same permissions.) 

6. Configure FactoryTalk Security to use single sign-on. Still in the FactoryTalk Administration Console, 
navigate to System > Policies > System Policies in the Explorer pane. Double-click Security Policy. Set the 
Use single sign-on policy to Enabled. 

The preceding configurations can be done using the Agent Services Logon Configuration utility. See below for 
detailed instructions. 

If operating in a Windows workgroup 
On each agent computer 
Perform these steps on each agent computer in the system. These steps show you how to create a new Windows user 
account and a new FactoryTalk user account for each agent computer. 

FactoryTalk AssetCentre provides a utility to facilitate the process of creating and setting security credentials 
necessary for secured RSLogix editors. You can configure the agent computer using the utility or manually configure 
the agent computer. 
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To configure the agent computer using the Agent Services Logon Configuration utility 
1. From Windows Start menu, select All Programs > Rockwell Software > FactoryTalk AssetCentre Agent > 

Agent Services Logon Configuration. 
2. Use the Agent Services Logon Configuration dialog box to create and set security credentials: 

a. In the User Name field, enter a user name. The default user name is AssetCentre_DR. 

 
Tip: The name must follow the Windows user name policies, for example: 
• User names must be no more than 20 characters in length. 
• User names cannot contain certain characters. Invalid characters include: 
" / \ [ ] : ; | = , + * ? < > 

a. In the Password field, enter a password for the user. 

b. In the Confirm Password field, enter the password again. 

c. When complete, click OK. 

The utility creates the user as a local Windows administrator account and adds it to FactoryTalk as a 
Windows-linked user account. The FactoryTalk AssetCentre VerificationAgent service is logged on as the 
user. The utility also configures the necessary security permissions for Logix Designer application, 
RSLogix 5000, RSLogix 500, and RSLogix 5 software packages. 

To manually configure the agent computer 
1. On the agent computer, use the Computer Management utility in Microsoft Windows to create a Windows 

user account that can be used to authenticate with FactoryTalk Security. 
2. Add the new Windows user account to the local Administrators group. 
3. Configure both services to run as the new Windows user account created in step 1. To do so, open the 

Services utility in Microsoft Windows, find the VerificationAgent service and edit its properties to log on as 
the account. 

4. Open the FactoryTalk Administration Console and add the new Windows user account created above as a 
new Windows-linked user. 

On any computer in the system 
Perform these steps on any computer connected to the FactoryTalk Network Directory. These steps need only be 
performed once and will be in effect for the entire FactoryTalk Network Directory. 

1. In the FactoryTalk Administration Console, create a new user group called Local Agent Users. 
2. The users created on different agent computers in the previous section (whether using the utility, or added 

manually) all appear in the FactoryTalk Network Directory as individual users. Add each of these new 
FactoryTalk users to the Local Agent Users group. This will facilitate making security settings because you 
will be able to set them once for the whole group, rather than for each user. 

3. Grant the Local Agent Users group read access to the FactoryTalk Directory. To do so, right-click the Network 
node at the top of the tree, and then select Security. On the Permissions tab, select the Local Agent Users 
group and then expand the Common permissions group. Make sure the Read permission is set to Allow. 

4. Set permissions for your RSLogix family software packages (depending on what type of processors you are 
using). Under System in the Explorer pane, right-click Networks and Devices and select Security. If the 
Local Agent Users group does not appear in the list, add it. On the Permissions tab, select the Local Agent 
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Users group. Expand the permissions group for the appropriate software and set the following permissions 
to Allow: 

• For RSLogix 5 grant Offline Program File Monitoring, Save, and Upload. 
• For RSLogix 500 grant Offline Program File Monitoring, Save, and Upload. 
• For RSLogix 5000 grant Project: Export, Project: Go Online, Project: Open, Project: Save, and Project: 

Upload. (Use this group for Logix Designer application and grant the same permissions.) 

5. Configure FactoryTalk Security to use single sign-on. Still in the FactoryTalk Administration Console, 
navigate to System > Policies > System Policies in the Explorer pane. Double-click Security Policy. Set the 
Use single sign-on policy to Enabled. 

Step 2: Read and accept license agreements 
End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being 
installed, there may be more than one license agreement on this page. The individual license agreements are listed 
above the text box. 

Some software products may be delivered or made available only after you agree to the terms and conditions of each 
of the license agreements. 

1. On the End User License Agreements page, select each agreement and read the agreement carefully. 
2. When all license agreements have been read, select Accept All. 

Step 3: Start the installation 
After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software 
applications selected previously. No further user input is required. 

Step 4: Finish the installation 
Restart the computer to complete the installation. 

Configure for security-enabled RSLogix family software 
If FactoryTalk Security is enabled in your RSLogix family software (RSLogix 5000, RSLogix 500, or RSLogix 5), you 
must configure the Disaster Recovery agent, and FactoryTalk Security to grant the necessary permissions for 
Disaster Recovery operations. FactoryTalk Security is always enabled in Studio 5000 Logix Designer and RSLogix 
5000. 

These instructions assume that the FactoryTalk AssetCentre agent software has been installed, and that all RSLogix 
family software packages that will be used in the system are also installed on each agent computer. 

• To configure the FactoryTalk AssetCentre agents and FactoryTalk Security in a Windows domain, follow 
instructions in If operating in a Windows domain on page 27. 

• To configure the FactoryTalk AssetCentre agents and FactoryTalk Security in a Windows workgroup, follow 
instructions in If operating in a Windows workgroup on page 27. 
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Check whether the agent software is current 
Unlike the FactoryTalk AssetCentre client, the FactoryTalk AssetCentre agent does not show a message if the agent 
does not have the latest version of the software. Instead, the agent does not start, and logs a message in the System 
Event log and the AssetCentre Event log. 

To check whether the FactoryTalk AssetCentre software on the agent is up to date 
1. Click Start, and then use search to search for AssetCentre Client. 
2. Click AssetCentre Client. 

FactoryTalk AssetCentre client appears. 

3. Check the number of running agent computers. 

It is displayed in the bottom right corner of the window on the status bar. If one or more agents are not 
running, and the client software has been recently updated, then the agent software may need to be updated 
as well. 
To update the agent software, follow the Steps to install the FactoryTalk AssetCentre agent software on page 
25. If you start the installation from the FactoryTalk AssetCentre server website, the installer searches the 
computer for components that need to be updated, and shows the results in this window. Components that 
will be updated are indicated with a computer icon and a checked box. 
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Chapter 4 

Install FactoryTalk AssetCentre clients 

This chapter describes: 

• Before you install FactoryTalk AssetCentre clients on page 31 
• Steps to install FactoryTalk AssetCentre clients on page 32 
• Check whether the client is installed correctly on page 34 

Before you install FactoryTalk AssetCentre clients 
The FactoryTalk AssetCentre client software provides the user interface for FactoryTalk AssetCentre. It is through 
the client that you perform tasks such as checking files in and out, creating and running scheduled events, and 
viewing logs. For more information on what you can do with FactoryTalk AssetCentre client software, see the 
FactoryTalk AssetCentre Help (once the client is installed). 

 
Tip: Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 R2, it is 
required that you install the following Windows update: 
Windows Server 2012 R2 update: April 2014 

Install the FactoryTalk AssetCentre client software on all computers on which you want to use FactoryTalk 
AssetCentre. 

The client is not required on the FactoryTalk AssetCentre server computer, but you can install it on the server if 
desired. 

Where to install FactoryTalk AssetCentre clients 
 

Note: For current information on the system requirements for the FactoryTalk AssetCentre software, see 
FactoryTalk AssetCentre Release Notes and the Product Compatibility and Download Center. 

Install the client on any computer 
• From which you want to access the FactoryTalk AssetCentre client software (to edit the representation of 

your assets, to view logs, to create schedules, to search the logs, and so on). 
• That is capable of running the client software (see Client computer requirements on page 9). 
• That is connected to the FactoryTalk AssetCentre server. 
• From which FactoryTalk audits are desired. 

The Disaster Recovery capability provides the ability to schedule a comparison between master files, and processor 
program and data files. To edit the file and data settings for a compare operation for PLC-5, SLC 500, or MicroLogix 
processors, you must have RSLogix 5, or RSLogix 500 software installed on the client computer. 

https://support.microsoft.com/en-us/kb/2919355
https://compatibility.rockwellautomation.com/Pages/home.aspx
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Steps to install FactoryTalk AssetCentre clients 
The Setup wizard installation process includes the following steps: 

• Step 1: Launch the Setup wizard and select what to install on page 32 
• Step 2: Read and accept license agreements on page 34 
• Step 3: Start the installation on page 34 
• Step 4: Finish the installation on page 34 

Step 1: Launch the Setup wizard and select what to install 
You can install the client using either the installation package or the FactoryTalk AssetCentre server website. 

To install a FactoryTalk AssetCentre client using the installation package 
1. Log on to your server computer as an administrator, or as a user with administrative privileges. 
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD 

in the computer's DVD drive. 

Run D:\setup.exe, where D:\ is the drive containing the DVD. 

3. Select AssetCentre Client. 

 
Tip: To install AssetCentre Server, AssetCentre Client, and AssetCentre Agent at the same time, 
select AssetCentre Custom Installation. Custom installation allows you to install more than 
one or all of the installation components. 

4. To install all components available in the selected software using the recommended settings, click Install 
now and skip to Step 2: Read and accept license agreements on page 34. 

5. To select which components to install, click Customize. 
6. On the Customize page: 

• To install web service for FactoryTalk Security, expand FactoryTalk Services Platform v6.21.00 and select 
FactoryTalk Security Web Service. 

• To register EDS files from devices to allow device communications in the Network Browser, expand 
FactoryTalk Services Platform v6.21.00, expand FactoryTalk Linx v6.21.00, and then select Register EDS 
Files. If you are running out of storage, clear this check box. However, clearing this check box turns off the 
EDS Parameter shortcut function. 

• To enable security for Rockwell Software security clients, expand RSLinx Classic v4.21.00 and select 
Enable Security. 

• If the installation detects the Step7 editor file (S7tgtopx.exe) at either of the following paths, you can 
choose to select Step7 Version 5.6 sp1 and install the feature. If you have the Step7 editor file installed, 
make sure they are located at either of the following paths for the installation to detect. 

• C:\Siemens\Step7\s7bin 
• C:\Program Files\Siemens\Step7\s7bin or C:\Program Files (x86)\Siemens\Step7\s7bin 
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Tip: If you have S7 processors, you may also need to install the Step7 feature. This step 
is not required for Disaster Recovery actions, it merely associates project files with the 
appropriate editor. 
You can install the Step7 feature at this point or install it after the installation. To install 
it after installing FactoryTalk AssetCentre Client: 
1. Run setup.exe in the installation package. 
2. Select AssetCentre Client and click Modify. 
3. Expand AssetCentre Client v11.00.00 and select Step7 Version 5.6 sp1. 
4. Click Modify. 

• To install the FactoryTalk Updater utility, expand Tools and then select FactoryTalk Updater Agent 
v2.00.00. It assists management of installed Rockwell Automation software by announcing new versions 
and patch roll-ups. Registering for updates is not required to receive announcements from the 
FactoryTalk Updater. 

7. Select the location for the software. The default location is C:\. 
8. Click Install. 

To install a FactoryTalk AssetCentre client using the FactoryTalk AssetCentre server website 
1. Open Internet Explorer, and in the Address box, type the following: 

http://servername/rockwellsoftware/assetcentre 
where servername is the name of your FactoryTalk AssetCentre server computer. 
For example, if your FactoryTalk AssetCentre server computer name is MYSERVER, type the following: 
http://MYSERVER/rockwellsoftware/assetcentre 

 
• Tip: If you are using SSL, then start the address with https:// instead of http://. 
• If you have changed the default port in site binding on page 77, you need to include the self-

defined port number in the computer name part in the form as MYSERVER:PortNumber. 
• If you install the FactoryTalk AssetCentre agent software on the FactoryTalk AssetCentre 

server computer, type the following in the Address box: 
http://localhost/rockwellsoftware/assetcentre. 

2. Press Enter. 

Internet Explorer shows a page from the server that allows you to install the FactoryTalk AssetCentre client 
software. 

3. Click Install AssetCentre Client on this computer. 

The installation automatically starts when the installation package is downloaded. 
Tip: If Internet Explorer shows an error message that it cannot connect to the 

install web page, try bypassing the proxy for local addresses. Also make sure 
that IIS is running on the server. For information on running IIS see Web page 
for installing the FactoryTalk AssetCentre client and agent cannot be shown on 
page 112. 
If in one of the following situations: 
• Internet Explorer shows a warning about opening possibly unsafe content 

or downloading possibly unsafe files 
• Windows SmartScreen prevents the installation 
Add the FactoryTalk AssetCentre Web site (URL above) to your Trusted Sites. 
See your Internet Explorer documentation for more information. 
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Step 2: Read and accept license agreements 
End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being 
installed, there may be more than one license agreement on this page. The individual license agreements are listed 
above the text box. 

Some software products may be delivered or made available only after you agree to the terms and conditions of each 
of the license agreements. 

1. On the End User License Agreements page, select each agreement and read the agreement carefully. 
2. When all license agreements have been read, select Accept All. 

Step 3: Start the installation 
After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software 
applications selected previously. No further user input is required. 

Step 4: Finish the installation 
Restart the computer to complete the installation. 

When the installation is finished, it is recommended that you: 

• Install the latest FactoryTalk AssetCentre patches. 

See Knowledgebase Document ID: QA15600 - FactoryTalk AssetCentre Patch Roll-up for 3.0 and later. 

• Configure the SSL protocol. 

See Configure the SSL protocol for FactoryTalk AssetCentre on page 73 

Check whether the client is installed correctly 
To check whether the client is correctly installed and connected to the FactoryTalk AssetCentre server 

1. Click Start, and then use search to search for AssetCentre Client. 
2. Click AssetCentre Client. 

FactoryTalk AssetCentre Client appears. 
When the client runs, it checks the server for the latest version of the client software. If the client software is 
not the latest version, the following message is displayed: 
The client and server versions are incompatible. 
To update the client software, follow the Steps to install the FactoryTalk AssetCentre clients on page 32 at the 
start of Chapter 4. 
For information on getting started with the software, see the FactoryTalk AssetCentre Getting Results Guide. 

 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/473892
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Chapter 5 

Custom install the FactoryTalk AssetCentre software 

FactoryTalk AssetCentre supports custom installation of the FactoryTalk AssetCentre software. Custom installation 
allows you to install more than one or all of the installation components, including AssetCentre Server, AssetCentre 
Client, and AssetCentre Agent. 

Before starting the installation of FactoryTalk AssetCentre system, you should ensure that: 

FactoryTalk AssetCentre server 

• You select the Windows Authentication, when you install Microsoft SQL Server. 
IMPORTANT • If you select Mixed Mode when installing Microsoft SQL Server, you can use SQL 

Server Authentication to access remote database. 
• When using SQL Server Authentication, you must use silent or unattended setup 

to install FactoryTalk AssetCentre version 11.00.00 or later. 

• A Managed Service Account or group Managed Service Account is installed on your computer that is used as 
a domain controller, if you will configure the FactoryTalk AssetCentre server with a remote database. 

• Windows local user account, Windows Active Directory (AD) user account or a Windows AD group where 
your user account is a member has been assigned SQL Server system administrator role. 

FactoryTalk AssetCentre agent 

• You must have the appropriate RSLogix family software for your devices installed on the agent computer to 
run Disaster Recovery schedules. 

 

To custom install FactoryTalk AssetCentre 
1. Log on to your server computer as an administrator, or as a user with administrative privileges. 
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD 

in the computer's DVD drive. 

Run D:\setup.exe, where D:\ is the drive containing the DVD. 

3. Select AssetCentre Custom Installation. 
4. Select Customize. 
5. On the Customize page, select the product components to install. 

The grayed-out and selected check boxes indicate that the software will be automatically installed. 
FactoryTalk AssetCentre allows selecting or clearing the following check boxes: 

• AssetCentre Server v11.00.00 
• AssetCentre Agent v11.00.00 
• AssetCentre Client v11.00.00 
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• Logix Designer Compare Tool v8.12.00 
• RSLogix 5 v10.00.00 
• RSLogix 500 v12.00.00 
• FactoryTalk View ME Transfer Utility v12.00.00 
• FactoryTalk Updater Agent v2.00.00 

If the computer to which you install the FactoryTalk AssetCentre software meets the system requirements, 
the software product check boxes are selected by default. 
If you cleared any product check box, the related prerequisite product check boxes will be turned on for you 
to clear. 

• To install web service for FactoryTalk Security, expand FactoryTalk Services Platform v6.21.00 and select 
FactoryTalk Security Web Service. 

• To register EDS files from devices to allow device communications in the Network Browser, expand 
FactoryTalk Services Platform v6.21.00, expand FactoryTalk Linx v6.21.00, and then select Register EDS 
Files. If you are running out of storage, clear this check box. However, clearing this check box turns off the 
EDS Parameter shortcut function. 

• To enable security for Rockwell Software security clients, expand RSLinx Classic v4.21.00 and select 
Enable Security. 

• If the installation detects the Step7 editor file (S7tgtopx.exe) at either of the following paths, you can 
choose to select Step7 Version 5.6 sp1 and install the feature. If you have the Step7 editor file installed, 
make sure they are located at either of the following paths for the installation to detect. 

• C:\Siemens\Step7\s7bin 
• C:\Program Files\Siemens\Step7\s7bin or C:\Program Files (x86)\Siemens\Step7\s7bin 

 
Tip: If you have S7 processors, you may also need to install the Step7 feature. This step 
is not required for Disaster Recovery actions, it merely associates project files with the 
appropriate editor. 
You can install the Step7 feature at this point or install it after the installation. To install 
it after installing FactoryTalk AssetCentre Client: 
1. Run setup.exe in the installation package. 
2. Select AssetCentre Client and click Modify. 
3. Expand AssetCentre Client v11.00.00 and select Step7 Version 5.6 sp1. 
4. Click Modify. 

• To install the FactoryTalk Updater utility, expand Tools and then select FactoryTalk Updater Agent 
v2.00.00. It assists management of installed Rockwell Automation software by announcing new versions 
and patch roll-ups. Registering for updates is not required to receive announcements from the 
FactoryTalk Updater. 

6. Select the location for the software. The default location is C:\. 
7. Select Next. 
8. Follow the on-screen instructions to complete the installation. 

For more information on the configuration of the FactoryTalk AssetCentre server, refer to Install the 
ctoryTalk AssetCentre Sever software on page 15.  
For more information on the security configuration of RSLogix 5 and RSLogix 500, refer to Install the 
FactoryTalk AssetCentre Agent software on page 23. 
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WARNING: It is generally recommended to turn on HTTPS. The potential security risks of 
turning off HTTPS are ass below: 
• The data is transmitted without encryption across a network, which will cause leakage of 

information, if other solutions, such as IPSEC, are not used. 
• The system may be vulnerable to a Remote Code Execution (RCE) attack. 
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Chapter 6 

Install the AssetCentre Diagnostics Connector 

If you want the diagnostics information generated by other Rockwell Automation software products of the same 
FactoryTalk Directory to be recorded in the FactoryTalk AssetCentre database, install the AssetCentre Diagnostics 
Connector. The AssetCentre Diagnostics Connector option only includes the FactoryTalk AssetCentre components 
that are necessary for the log experience without having to install the full FactoryTalk AssetCentre Client. 

Steps to install the AssetCentre Diagnostics Connector 
The Setup wizard installation process includes the following steps: 

• Step 1: Launch the Setup wizard and select what to install on page 39 
• Step 2: Read and accept license agreements on page 39 
• Step 3: Start the installation on page 40 
• Step 4: Finish the installation on page 40 

Step 1: Launch the Setup wizard and select what to install 
1. Log on to your server computer as an administrator, or as a user with administrative privileges. 
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD 

in the computer's DVD drive. 

Run D:\setup.exe, where D:\ is the drive containing the DVD. 

3. Select AssetCentre Diagnostics Connector (Optional). 
4. To install all components available in the selected component using the recommended settings, click Install 

now and skip to Step 2: Read and accept license agreements on page 39. 
5. To select which components to install, select Customize. 
6. On the Customize page: 

• To install web service for FactoryTalk Security, expand FactoryTalk Services Platform v6.21.00 and select 
FactoryTalk Security Web Service. 

• AssetCentre Common Components are what you need to install as the diagnostics connector. 

7. Select the location for the software. The default location is C:\. 
8. Select Install. 

Step 2: Read and accept license agreements 
End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being 
installed, there may be more than one license agreement on this page. The individual license agreements are listed 
above the text box. 
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Some software products may be delivered or made available only after you agree to the terms and conditions of each 
of the license agreements. 

1. On the End User License Agreements page, select each agreement and read the agreement carefully. 
2. When all license agreements have been read, select Accept All. 

Step 3: Start the installation 
After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software 
applications selected previously. No further user input is required. 

Step 4: Finish the installation 
Restart the computer to complete the installation. 
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Chapter 7 

Upgrade FactoryTalk AssetCentre 

If you upgrade from a previous version of FactoryTalk AssetCentre, use the following steps to upgrade from 
FactoryTalk AssetCentre versions 7.00.00 and later to version 11.00.00. 

• To upgrade an RSMACC system to FactoryTalk AssetCentre, follow the instructions in Knowledgebase 
Document ID: IN3311 - Upgrade an existing RSMACC system to FactoryTalk AssetCentre. 

In rare situations, especially on low-performance computers, a dialog box may open during the installation when 
upgrading FactoryTalk AssetCentre. The dialog box indicates that the FactoryTalk AssetCentre server service needs 
to be stopped. If you use the unattended setup to upgrade FactoryTalk AssetCentre, you need to click Yes to stop the 
service or click No to cancel the installation. 

Starting from FactoryTalk AssetCentre version 10.00.00, process device capabilities are not supported. 

IMPORTANT • After upgrading to FactoryTalk AssetCentre version 10.00 and later from earlier 
versions, you will no longer be able to use Process Device Configuration and Calibration 
Management functionality. 

After upgrading from FactoryTalk AssetCentre version 9.00 or earlier to version 10.00 and later, General DTM 
Device, Equipment, Instrument, Loop, System, and Test Instrument process devices are not available in the asset 
catalog. The Process Device Configuration Field Edition, ProcalV5 Data Source Configuration, and Procal DB 
Connector Installer will be removed. 

If Process Device Configuration is required for your system, we recommend you considering Endress+Hauser 
FieldCare which offers a comprehensive tool for managing process instruments called FieldCare SFE500. 
Endress+Hauser FieldCare is scalable, which allows to fulfill tasks from Device Setup to Plant Asset Management. 
FieldCare can be used with instruments communicating via Profibus-PA, Foundation Fieldbus, and HART. 

All calibration records and information are retained in ProCalV5, thus the previously existing process device assets 
will be displayed in the asset tree. You can still cut, copy, and paste the existing process devices in the asset tree. 
However, their hardware and asset properties will be disabled. The ProCalV5 Company and ProCalV5 Linked Item 
properties of Instrument, Equipment, Loop, System, and Test Instrument are removed from the asset properties 
dialog box. Process devices will still consume the capacity activation. If you are still owning FactoryTalk AssetCentre 
Calibration Management, we recommend you contacting the following vendors for more solutions: 

• Prime Technologies (https://www.primetechpa.com/) 
• CompuCal (https://compucalcalibrations.com/) 

When upgrading FactoryTalk AssetCentre to version 9.00.00 and later, the logon user of the FactoryTalk 
AssetCentre AgentController service will be set to the default LocalSystem no matter what the previous logon user 
was. Do not change the default LocalSystem logon user. Doing so will cause disaster recovery schedule failures of 
FactoryTalk View Site Edition assets.  

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/454396
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When upgrading FactoryTalk AssetCentre to version 10.00.00 and later, the FactoryTalk AssetCentre 
VerificationAgent service will be reset to the default LocalSystem account regardless of the previous configuration. If 
the previous service configuration was configured to use a user account, such as AssetCentre_DR, it is required to 
open Agent Controller Launch Control Panel to re-configure the VerificationAgent to use a user account. 

If upgrading from a previous version of FactoryTalk AssetCentre, your customized settings will be kept. If repairing 
the components of FactoryTalk AssetCentre, your customized settings will be restored to the default. 

To upgrade FactoryTalk AssetCentre to version 11.00.00 with a local database, AssetCentre server will be configured 
with a Windows virtual account by default. For more information, see Step 2: Configure the FactoryTalk AssetCentre 
server on page 20. 

To upgrade FactoryTalk AssetCentre to version 11.00.00 with a remote database, AssetCentre server can be 
configured with a Managed Service Account, a group Managed Service Account, or a SQL Server account. For more 
information, refer to Install FactoryTalk AssetCentre Server software on page 15. 

IMPORTANT To upgrade FactoryTalk AssetCentre to version 11.00.00 or later with SQL Server 
Authentication, you must use silent or unattended setup to install it. 

To upgrade FactoryTalk AssetCentre to version 11.00.00 with a SQL user account, FactoryTalk AssetCentre installer 
will create AssetCentreUser and AsseCentreDBMaintenance for upgrading. 

 
WARNING: To upgrade FactoryTalk AssetCentre to version 11.00.00, it is generally recommended to 
turn on HTTPS. The security risks of tuning off HTTPS are as below: 
• The data is transmitted without encryption across a network, which will cause leakage of 

information, if other solutions, such as IPSEC, are not used. 
• The system may be vulnerable to a Remote Code Execution (RCE) attack. 

After upgrading to FactoryTalk AssetCentre to version 11.00.00 and the HTTPS is turned on, you can do the 
following: 
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• If the SSL or TLS certificate is already configured on your computer, it is recommended to select the Require 
SSL check box through Internet Information Services (IIS) Manager. 

 
• If the SSL or TLS certificate is not configured, you must Configure the SSL protocol for FactoryTalk 

AssetCentre on page 73. It is also recommended to select the Require SSL check box through Internet 
Information Services (IIS) Manager. 

IMPORTANT After configuring the SSL or TLS certificate, you must manually restart 
FactoryTalk AssetCentre Server service through Control Panel > System and 
Security > Administrative Tools > Services, or restart your computer. 

To upgrade from CPR 9-compatible version 7.00 or later 
1. Upgrade optional software products. See Optional software upgrades on page 60. 
2. Install the FactoryTalk AssetCentre server, client and agent software. Follow the instructions in Chapter 3 to 

use the silent or unattended installation or Chapter 4 through Chapter 7 to use the standard Setup wizard. 

Upgrade to new version of AssetCentre and move existing database to new server 
If you are installing FactoryTalk AssetCentre on a 64-bit operating system see the Rockwell Automation Product 
Compatibility & Download Center website for a list of operating systems that FactoryTalk AssetCentre supports. 

 
Note: Always backup the AssetCentre database prior to making any changes to your system 
configuration. 

Ensure on the new server that following components are in place prior to installing the FactoryTalk AssetCentre 
server components: 

• Microsoft Internet Information Services (IIS) 
• Microsoft SQL Server 

 
Note: If you are upgrading your system to a new version of Microsoft SQL Server you will need to 
include the Integration Tools of the Microsoft SQL server installation to ensure SQL can 
successfully migrate a database to the new version. 

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
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To Update FactoryTalk AssetCentre Database to New Version on a New Server 
1. Move the FactoryTalk AssetCentre database backup (.bak) file from the old server to the new server. 
2. Using the Microsoft SQL Server Management Studio on the new server restore the .bak file to this server, for 

more information on how to backup and restore a Microsoft SQL database, see Backing up and Restoring 
FactoryTalk AssetCentre with Microsoft SQL Server on page 44. 

3. On the new server from the SQL Management Studio expand the AssetCentre Database > Security folder. 
4. Find the AssetCentreUser user and delete this user from the newly restored database. 
5. Click Yes when asked to delete the associated schema with this user. 

 
Note: This user must be deleted as the installation of the AssetCentre server installation will re-
create a new AssetCentreUser tied to the AssetCentre Server instance running on this system. 

6. Now that the AssetCentreUser has been removed from the AssetCentre database, also delete the 
AssetCentreUser SQL login user. 

7. Proceed with the AssetCentre Server installation, see Install the FactoryTalk AssetCentre server software on 
page 15. 

 
Note: After upgrading FactoryTalk AssetCentre from previous version to version 10.00.00 and 
later, and restarting your computer, you can check the SDF file to confirm whether the migration 
from SDF to MDF succeeded. If the size of the SDF file is still large (for example, more than 1GB), 
in the Control Panel, you can repair FactoryTalk AssetCentre Common Components to restart 
the migration. 

 

Backing up and Restoring FactoryTalk AssetCentre with Microsoft SQL Server 
Proper retention of data is a mission critical task in any industry. For FactoryTalk AssetCentre, this means backing 
up the data stored in the FactoryTalk AssetCentre database. All information in FactoryTalk AssetCentre, from audits 
and events, to the asset tree itself, is stored in the AssetCentre database within the Microsoft SQL (MSSQL) server. 

Planning an AssetCentre Maintenance Window 

When backing up any production system, such as FactoryTalk AssetCentre, it is critical to plan the event as a 
scheduled maintenance window. A maintenance window is a period of time that is planned to make a production 
system unavailable to its users, thus allowing for proper maintenance to that system to ensure continued system 
health. During the backup of the FactoryTalk AssetCentre system, user access should be limited. While users can 
continue to query the system during the backup, it is not recommended to have any user activity occur during this 
time. Fortunately, the Microsoft SQL server is capable of handling user queries of a database it is currently backing 
up, meaning that the FactoryTalk AssetCentre system does not need to be stopped in order to proceed with a backup. 

Backing Up FactoryTalk AssetCentre in Microsoft SQL Server 2014 

The following set of instructions is intended for use on systems using Microsoft SQL Server 2014. Proper steps for 
manual backup of the AssetCentre database and the accompanying transaction log will be shown. A backup 
operation will essentially create a copy of the current database contents, and store them in a user-defined location. It 
should be noted that this process can also be automated, which is covered at the end of this section. 

AssetCentre Database Backup 
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During the backup of the FactoryTalk AssetCentre system, user access should be limited. While users can continue 
to query the system during the backup, it is not recommended to have any user activity occur during this time. 
Additionally, it is advisable to run the Database Cleanup Wizard from the FactoryTalk AssetCentre client prior to 
backing up the system to clean out any aged data that no longer needs to be retained (see online help in FactoryTalk 
AssetCentre client for this procedure.) 

1. From the Start menu select SQL Server 2014 Management Studio. 

 
2. Click Connect. 
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3. Once the Microsoft SQL Server 2014 Management Studio has connected to the database server, navigate to 
the AssetCentre database. 

 
4. Right-click on the AssetCentre database and then select Tasks > Back Up…. 

 
5. The Back Up Database – AssetCentre screen is displayed, Observe the following information: 
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6. Note the Media Options and Backup Options from the tree on the left of the screen. In this example, all 
options are left at default. 

 
7. Click OK to initiate the backup. 
8. Note the Progress panel in the bottom left of the screen. 

 
9. Upon successful completion of the backup, the following window will be displayed. 

 
The AssetCentre database is now backed up. 

AssetCentre Database Transaction Logs Backup 
It is strongly recommended to backup the database transaction logs in addition to the database itself. The 
transaction logs essentially keep audits of the database, recording actions performed upon it. Both the transaction 
logs and database can be stored in the same file, specified in the section above on how to back up the database. 

1. Right-click on the AssetCentre database, and then select Tasks > Back Up…. 
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The following screen will be displayed: 

 
2. Note the Media Options and Backup Options from the tree on the left of the screen. In this example, all 

options are left at default. 

 
3. Click OK to initiate the backup. 

Note the Progress panel in the bottom left of the screen. 

4. Upon successful completion of the backup, the following window will be displayed, click OK. 

 
The AssetCentre database’s transaction logs have now been backed up successfully. 

Scheduling Backups 
Using the Microsoft SQL Server Agent, it is possible to schedule backups of the AssetCentre database and 
transaction logs on a user defined schedule. Typically, an entire database backup is scheduled less often than the 
transaction log backup (for example, the database might be backed up weekly, whereas the transaction logs are 
backed up daily.) 
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Since the Microsoft SQL Server Agent is performing the operation, its service must be running. It is recommended 
to set this service to automatic, such that the service will start on reboots without user intervention. 

 
Note: The steps below assume a configuration of two separate maintenance plans: one for the 
transaction log and 
one for the database itself. It is possible to configure both in the same plan. 

1. Ensure that the SQL Server Agent is started. This can be accomplished directly from the Microsoft SQL 
ServerManagement Studio, at the bottom of the navigation tree. 

 
2. If the Agent is not started, right-click on it, and then select Start. 

 
3. Click Yes when prompted to start the service. 
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4. Once the SQL Server Agent is started, right-click on Management > Maintenance Plans, and then select 
Maintenance Plan Wizard. 

 
5. Enter AssetCentre_DB_Backup as the name for the maintenance plan, and then click the Change button to 

schedule the plan. 
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6. Use the following screen to configure the schedule for the operation, then click OK to continue. 

 
7. Click Next to progress past this screen now that the schedule is configured. 
8. Select Back Up Database (Full) to configure this maintenance task to back up the database itself. Click Next 

to continue. 

 
9. Click Next again. 
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10. Select the AssetCentre database from the drop down menu and click OK. 

 
11. Under Create a backup file for every database, specify the location to store the backup file. 

 
Note: A preferred location would be a separate hard drive from the one on which the database 
resides (thus saving the backup location if the database’s hard drive fails.) 

12. Click Next. 
13. Enter the location to save the log files of the backup. 
14. Click Next. 

 
Note: It is possible to configure email reporting from this screen. 
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15. Click Finish to finalize the maintenance plan. 

 
16. When complete, the following screen will be displayed: 

 
17. Once the success of the operation is reported, click Close. 
18. A database backup has now been scheduled. 

 
Note: If a maintenance plan for the transaction log is also desired, simply follow these steps 
again and select Back Up Database (Transaction Log) instead of Back Up Database (Full). 

Restoring FactoryTalk AssetCentre in Microsoft SQL Server 2014 
Before beginning the process of restoring the database, all users of the FactoryTalk AssetCentre system should be 
disconnected. It is advisable to simply stop the FactoryTalk AssetCentre server service until the Microsoft SQL 
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database restore and subsequent re-connecting of the FactoryTalk AssetCentre server is complete. Additionally, the 
World Wide Web Publishing service should be stopped until the entire procedure is complete. 

1. To disable the FactoryTalk AssetCentre server service, open up the Service Control Manager (Start > 
Services). 

 
2. Right-click on the FactoryTalk AssetCentre Server listing and select Stop. 

 
3. Stop the World Wide Web Publishing service in the same way. 

 
4. Return to the SQL Server Management Studio 
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5. Right-click on Databases, then select Restore Database. 

 
6. Select Device, and then click the Browse button. 

 
7. Click Add. 
8. Browse to the location where you store the backup file, and then select it, then press OK twice to continue. 
9. The backup list below the browse button will populate. Check all check boxes. 
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Note: If different options are selected, such as overwriting on each backup, or if a previous 
backup file is used, there will 
be a different number of rows to select from. Additionally, if no transaction logs were backed 
up, there may only be one 
checkbox available, corresponding to the AssetCentre database itself. It is also possible to 
perform restores of just the 
transaction log or database, depending on the checkbox selections. These steps show the 
process for restoring both at 
the same time. 

10. Click Media Options. 

 
11. Select Overwrite the existing database. 

 
12. Click OK. SQL will now restore the AssetCentre database. Progress is reported at the top of the window: 

 

FactoryTalk AssetCentre Data Source Configuration Wizard 

If the AssetCentre database has been moved or restored on an Microsoft SQL Server, it is important to reconnect the 
FactoryTalk AssetCentre server to this new database. The steps below will walk through the FactoryTalk AssetCentre 
Data Source Configuration Wizard, installed by default along with the FactoryTalk AssetCentre server. 

 
Note: The FactoryTalk AssetCentre server and World Wide Web Publishing services should still be 
stopped at this point, following the restoration of the database. If this is not so, stop them now. 
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1. From the FactoryTalk AssetCentre server machine, go to the Start menu and select Data Source 
Configuration. 

 
2. Click Next on the first screen 
3. Enter the name of the Microsoft SQL Server in the FactoryTalk AssetCentre SQL Server dropdown menu, 

and then click Next. 

 

 
Note: If you want to turn on the TLS for the database, the full computer name is required when 
you specify the FactoryTalk AssetCentre SQL server. 
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4. Configure the Account name and communication security options as needed, and then click Next. 

 
5. Configure the FactoryTalk AssetCentre SQL Server Mirror properties if applicable, and then click Next. 

 

 
Note: If the Enable SQL Mirroring check box is selected, in the FactoryTalk AssetCentre SQL 
Server Mirror box, you can enter a name of Mirror Database Server or SQL Server Mirror that 
hosts the mirrored FactoryTalk AssetCentre Database. 
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6. Confirm the Database name and Connection Timeout values in the FactoryTalk AssetCentre SQL Server 
window, and then click Next. 

 
7. Click Finish, and a data source test window will appear. 
8. Press Test Data Source to test the connection that you’ve just configured and verify that the test completes 

successfully. 

 
9. Click Done to close the wizard. 
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10. Finally, start the FactoryTalk AssetCentre and World Wide Web Publishing services. From the Start menu, 
open the Services program. Start the World Wide Web Publishing service first Right-click on the World Wide 
Web Publishing listing and select Start. 

 
11. Start the FactoryTalk AssetCentre Server service in the same way. 

The FactoryTalk AssetCentre Server is now connected to the newly restored database. 
 

Optional software upgrades 
The FactoryTalk AssetCentre 11.00.00 installation package contains the following optional installations for these 
software products: 

• FactoryTalk Services Platform 
• FactoryTalk Activation Manager 
• FactoryTalk Linx (formerly RSLinx Enterprise) 
• FactoryTalk Alarms and Events 
• FactoryTalk View ME Transfer Utility 
• RSLinx Classic Lite 
• RSLogix 5 
• RSLogix 500 
• Logix Designer Compare Tool 
• FactoryTalk Updater Agent 

If earlier versions of the following software are installed on your computer, and you want their latest versions, you 
need to install them manually. See Location of setup files on page 61. 

• FactoryTalk View ME Transfer Utility 
• RSLogix 5 
• RSLogix 500 

If earlier versions of the following software are installed on your computer, and they are lower than the minimum 
versions required to install FactoryTalk AssetCentre, the FactoryTalk AssetCentre Setup wizard will upgrade the 
software automatically. 



 

 Rockwell Automation Publication - FTAC-IN005I-EN-E - March 2021 61 
 

• RSLinx Classic Lite 
• Logix Designer Compare Tool 

If the software versions are equal to or higher than the minimum versions required to install FactoryTalk 
AssetCentre, but lower than the versions included in the FactoryTalk AssetCentre installation package, the 
installation process will not upgrade the software automatically. If you want to use the latest versions instead, you 
must select the software check boxes during the installation of FactoryTalk AssetCentre. 

 
Tip: If you use FactoryTalk Services Platform CPR 9 SR 8, be sure to use the CPR 9 SR 8 versions of 
RSLinx Enterprise and RSLinx Classic Lite. 
If you want to upgrade the optional software products, we recommend that you upgrade them before 
installing FactoryTalk AssetCentre. 

 

Location of setup files 
The setup files for the optional upgrades are available in the FactoryTalk AssetCentre installation package. 

This product’s installation file... Is located in this folder... 

FactoryTalk View ME Transfer Utility 12.00.00-FTView\Tools\ME Transfer 
Utility\FactoryTalk View ME Transfer Utility.msi 

RSLogix 5 10.00.00-RSLogix 5\ENU\RSLogix 5 English 
10.00.00 (CPR 9).msi 

RSLogix 500 12.00.00-RSLogix 500\ENU\RSLogix 500 English 
12.00.00.msi 
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Chapter 8 

Use silent or unattended setup to install the FactoryTalk AssetCentre 
software 

FactoryTalk AssetCentre supports silent or unattended installation. Silent installation runs in a quiet mode without 
any user interface, while unattended installation runs in a quiet simple mode and shows progress through the UI. 
Unattended installation does not accept any input, but still shows error or restart messages. 

IMPORTANT Before starting silent or unattended setup to install the FactoryTalk AssetCentre software, 
ensure that your Windows Active Directory (AD) user account has been assigned the SQL 
Server system administrator (SA) role. 

Use command lines to specify properties to install FactoryTalk AssetCentre software automatically with little 
interaction. The silent or unattended installation supports the following installation modes: 

• FactoryTalk AssetCentre server 
• FactoryTalk AssetCentre client 
• FactoryTalk AssetCentre agent 
• FactoryTalk AssetCentre custom installation 

 
Tip: Unlike custom installation using the standard Setup wizard that allows you to select 
software products to install, the custom installation mode in silent or unattended setup 
automatically installs all FactoryTalk AssetCentre software, including FactoryTalk AssetCentre 
server, client, and agent. 

If you install FactoryTalk AssetCentre client or agent with RSLinx Classic using silent or unattended installation on 
32-bit operating systems, you must manually install the USB CIP package first. To manually install the USB CIP 
package, run it from FactoryTalk AssetCentre installation directory: \Redist\USBCIP_3.18.06\Setup.exe. 

During the silent or unattended installation, all associated Rockwell Automation software processes will be 
automatically terminated. Make sure to shut down all associated Rockwell Automation software products before 
installation. 

This chapter describes how to use silent or unattended setup to install the FactoryTalk AssetCentre software. If you 
want to use the standard Setup wizard to install the software step by step, see Chapter 4 through Chapter 7 for 
detailed instructions. 

Before performing the silent or unattended installation 
This section describes things you need to know: 

• Before you install the FactoryTalk AssetCentre server software using silent or unattended setup on page 64 
• Before you install the FactoryTalk AssetCentre client software using silent or unattended setup on page 64 
• Before you install FactoryTalk AssetCentre agents using unattended silent or setup on page 65 
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Before you install the FactoryTalk AssetCentre server software using silent or unattended 
setup 
The following checklist summarizes the basic tasks involved in the unattended installation of FactoryTalk 
AssetCentre server software along with supporting software. 

• Ensure that the user performing installation has administrative rights in Windows. 

 
Tip: Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 
R2, it is required that you install the following Windows update: 
Windows Server 2012 R2 update: April 2014 

• Ensure that the Windows account of the user performing the installation, or a Windows group of which the 
user performing the installation is a member, is assigned the Microsoft SQL Server System Administrator 
role before attempting the installation. This change is optional for Upgrade installations. 

• Ensure the following software or services is installed on the computer: 

• Microsoft SQL Server (can be located on a separate computer) 

• Schedule downtime for the system if you are upgrading operating applications or replacing computers 
during the installation. 

IMPORTANT If you plan to install on a remote machine and your current machine uses a 
software firewall (such as the Windows Firewall), you must manually permit File 
and Printer Sharing through your firewall. Consult the documentation for your 
firewall software for instructions. You must also open Port 80 (or whatever port is 
used for HTTP). 

The tasks listed above are the same as you perform with the standard step-to-step installation method. For detailed 
instructions, see Before you install the FactoryTalk AssetCentre server software on page 15. 

Before you install the FactoryTalk AssetCentre client software using silent or unattended 
setup 

 
Note: For current information on the system requirements for the FactoryTalk AssetCentre software, see 
FactoryTalk AssetCentre Release Notes and the Product Compatibility and Download Center. 

The FactoryTalk AssetCentre client software provides the user interface for FactoryTalk AssetCentre. It is through 
the client that you perform tasks such as checking files in and out, creating and running scheduled events, and 
viewing logs. For more information on what you can do with FactoryTalk AssetCentre client software, see the 
FactoryTalk AssetCentre Help (once the client is installed). 

 
Tip: Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 R2, it is 
required that you install the following Windows update: 
Windows Server 2012 R2 update: April 2014 

Install the FactoryTalk AssetCentre client software on all computers on which you want to use FactoryTalk 
AssetCentre. 

The client is not required on the FactoryTalk AssetCentre server computer, but you can install it on the server if 
desired. 

https://support.microsoft.com/en-us/kb/2919355
https://compatibility.rockwellautomation.com/Pages/home.aspx
https://support.microsoft.com/en-us/kb/2919355
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Install the client on any computer 
• From which you want to access the FactoryTalk AssetCentre client software (to edit the representation of 

your assets, to view logs, to create schedules, to search the logs, and so on). 
• That is capable of running the client software (see Client computer requirements on page 9). 
• That is connected to the FactoryTalk AssetCentre server. 
• From which FactoryTalk audits are desired. 

The Disaster Recovery capability provides the ability to schedule a comparison between master files, and processor 
program and data files. To edit the file and data settings for a compare operation for PLC-5, SLC 500, or MicroLogix 
processors, you must have RSLogix 5, or RSLogix 500 software installed on the client computer. 

Before you install FactoryTalk AssetCentre agents using silent or unattended setup 
 

Note: For current information on the system requirements for the FactoryTalk AssetCentre software, see 
FactoryTalk AssetCentre Release Notes and the Product Compatibility and Download Center. 

Agents are programs that communicate with the FactoryTalk AssetCentre server and perform scheduled tasks on 
behalf of the FactoryTalk AssetCentre server. Agents allow work to be distributed and shared among multiple 
computers to spread processing load and speed up operations. When a server needs an agent to perform a task, it 
locates the computer running the operation and assigns the task to that agent. The agent then reports the task's 
completion to the server. The Search feature, as well as purchased capabilities, such as Disaster Recovery 
capabilities, require the use of agents to perform scheduled operations. 

 
Tip: Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 R2, it is 
required that you install the following Windows update: 
Windows Server 2012 R2 update: April 2014 

Where to install the FactoryTalk AssetCentre agent software 
Agents can be installed on any computer that: 

• Is capable of running the agent software (see Agent computer requirements on page 11). 
• Is connected to the FactoryTalk AssetCentre Server. 
• Runs the FactoryTalk AssetCentre server, or the FactoryTalk AssetCentre client. 

If you also want to install Logix Designer Compare Tool, you need to manually install .NET Framework 3.5 before 
installing the agent on the following operating systems: 

• Windows Server 2019 
• Windows Server 2016 
• Windows Server 2012 R2 
• Windows 10 

See Before you install the FactoryTalk AssetCentre agent software on page 23 for more information about 
FactoryTalk AssetCentre agents. 

Perform silent or unattended installation 
Use command-line parameters to perform a silent or unattended installation of the software. 

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://support.microsoft.com/en-us/kb/2919355
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The command-line installation requires the administrator permission. The steps may vary slightly depending on 
your operating system. 

 
WARNING: HTTPS is turned on by default during silent or unattended installation. If you don't want 
to use it, you can turn it off with /noHTTPS. The potential security risks of turning off HTTPS 
are as below: 
• The data is transmitted without encryption across a network, which will cause leakage of 

information, if other solutions, such as IPSEC, are not used. 
• The system may be vulnerable to a Remote Code Execution (RCE) attack. 

To perform silent or unattended installation 
1. Close all Windows programs. 
2. Open the Command Prompt window. 
3. In the Command Prompt window, navigate to D:, where D: is the drive containing the FactoryTalk 

AssetCentre installation package. 

In this example, type D: and press Enter. 

 
Tip: If User Account Control dialog box shows, click Yes. 

4. Type a command with the following syntax:  

• Perform silent or unattended installation and access database with Windows Authentication 
Setup.exe {/Q | /QS} /IAcceptAllLicenseTerms [/AutoRestart] 
[/SetupLanguage=language] [/Record] [/Playback] /Product=product_name 
[/SerialNumber=serial_number] [/ProductKey=product_key] 
[/Version=product_version] [/InstallDrive=drive] [/SqlServer=SQL_location] 
[/DirectoryServer=FTD_server_location] 
Example: 
C:\Users\Administrator\Desktop\11.00.00-FTAssetCentre-DVDD\Setup.exe /Q 
/IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=ENU /Product="AssetCentre 
Server" /SerialNumber=2740J00396 /ProductKey=RYN62-LWBQ6 /Version=11.00.00 
/InstallDrive=D: /SqlServer="(local)" /DirectoryServer=FTDIRECTORY 
 
Setup.exe {/Q | /QS} /IAcceptAllLicenseTerms [/AutoRestart] 
[/SetupLanguage=language] [/Record] [/Playback] /Product=product_name 
[/SerialNumber=serial_number] [/ProductKey=product_key] 
[/Version=product_version] [/InstallDrive=drive] [/SqlServer=SQL_location] 
[/MSA=MSA or gMSA] [/DirectoryServer=FTD_server_location] 
Example: 
C:\Users\Administrator\Desktop\11.00.00-FTAssetCentre-DVDD\Setup.exe /Q 
/IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=ENU /Product="AssetCentre 
Server" /SerialNumber=2740J00396 /ProductKey=RYN62-LWBQ6 /Version=11.00.00 
/InstallDrive=D: /SqlServer="RemoteInstance" /MSA="RA\FTACgMSA$" 
/DirectoryServer=FTDIRECTORY 

• Perform silent or unattended installation with Windows Authentication and access database with SQL 
Authentication 
Setup.exe {/Q | /QS} /IAcceptAllLicenseTerms [/AutoRestart] 
[/SetupLanguage=language] [/Record] [/Playback] /Product=product_name 
[/SerialNumber=serial_number] [/ProductKey=product_key] 
[/Version=product_version] [/InstallDrive=drive] [/SqlServer=SQL_location] 
[sql] [/DirectoryServer=FTD_server_location] 
Example: 
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C:\Users\Administrator\Desktop\11.00.00-FTAssetCentre-DVDD\Setup.exe /Q 
/IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=ENU /Product="AssetCentre 
Server" /SerialNumber=2740J00396 /ProductKey=RYN62-LWBQ6 /Version=11.00.00 
/InstallDrive=D: /SqlServer="(local)" /sql 

• Perform silent or unattended installation with SQL Authentication and access database with Windows 
Authentication 
Setup.exe {/Q | /QS} /IAcceptAllLicenseTerms [/AutoRestart] 
[/SetupLanguage=language] [/Record] [/Playback] /Product=product_name 
[/SerialNumber=serial_number] [/ProductKey=product_key] 
[/Version=product_version] [/InstallDrive=drive] [/SqlServer=SQL_location] 
[/sa] [/SqlAdmin=SQL_administrator] [/SqlAdminPwd=SQL_admin_password] 
[/DirectoryServer=FTD_server_location] 
Example: 
C:\Users\Administrator\Desktop\11.00.00-FTAssetCentre-DVDD\Setup.exe /Q 
/IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=ENU /Product="AssetCentre 
Server" /SerialNumber=2740J00396 /ProductKey=RYN62-LWBQ6 /Version=11.00.00 
/InstallDrive=D: /SqlServer="(local)" /sa /SqlAdmin="sa" 
/SqlAdminPwd="SqlAdminPwd" /DirectoryServer=FTDIRECTORY 
 
Setup.exe {/Q | /QS} /IAcceptAllLicenseTerms [/AutoRestart] 
[/SetupLanguage=language] [/Record] [/Playback] /Product=product_name 
[/SerialNumber=serial_number] [/ProductKey=product_key] 
[/Version=product_version] [/InstallDrive=drive] [/SqlServer=SQL_location] 
[/sa] [/SqlAdmin=SQL_administrator] [/SqlAdminPwd=SQL_admin_password] [MSA=MSA 
or gMSA] [/DirectoryServer=FTD_server_location] 
Example: 
C:\Users\Administrator\Desktop\11.00.00-FTAssetCentre-DVDD\Setup.exe /Q 
/IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=ENU /Product="AssetCentre 
Server" /SerialNumber=2740J00396 /ProductKey=RYN62-LWBQ6 /Version=11.00.00 
/InstallDrive=D: /SqlServer="(local)" /sa /SqlAdmin="sa" 
/SqlAdminPwd="SqlAdminPwd" /MSA="RA\FTACgMSA$" /DirectoryServer=FTDIRECTORY 

• Perform silent or unattended installation with and access database SQL Authentication 
Setup.exe {/Q | /QS} /IAcceptAllLicenseTerms [/AutoRestart] 
[/SetupLanguage=language] [/Record] [/Playback] /Product=product_name 
[/SerialNumber=serial_number] [/ProductKey=product_key] 
[/Version=product_version] [/InstallDrive=drive] [/SqlServer=SQL_location] 
[/sa] [/SqlAdmin=SQL_administrator] [/SqlAdminPwd=SQL_admin_password] [/sql] 
[/DirectoryServer=FTD_server_location] 
Example: 
C:\Users\Administrator\Desktop\11.00.00-FTAssetCentre-DVDD\Setup.exe /Q 
/IAcceptAllLicenseTerms /AutoRestart /SetupLanguage=ENU /Product="AssetCentre 
Server" /SerialNumber=2740J00396 /ProductKey=RYN62-LWBQ6 /Version=11.00.00 
/InstallDrive=D: /SqlServer="(local)" /sa /SqlAdmin="sa" 
/SqlAdminPwd="SqlAdminPwd" /sql /DirectoryServer=FTDIRECTORY 

IMPORTANT • When installing FactoryTalk AssetCentre through silent or unattended 
installation, quotes are required for the parameters with space (for 
example, /Product="AssetCentre Server"). 

5. Press Enter. 

For more information about parameters, type Setup.exe /? or see Command-line parameters for silent or 
unattended installation on page 68. 
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Command-line parameters for silent or unattended installation 
Unattended or silent install 
Use command-line parameters to perform an unattended or silent installation of the software. 

IMPORTANT When installing or upgrading FactoryTalk AssetCentre to version 11.00.00 or later with SQL 
Server Authentication, you must use silent or unattended setup to install it. 

Command-line parameters 
The following table identifies the installation command-line parameters. Command-line parameters are  

case-insensitive. However, if a specified value includes a space, be sure to enclose the value in quotation marks (for 
example, "value with spaces"). 

Parameter Description 

/? Displays the usage options for installation parameters. 
/Q Silent Install, install runs in a quiet mode without any user interface. 

This parameter is recommended if you are deploying the software installation using an IT tool or script, 
and don’t expect to see any error or restart messages. When using this parameter, your IT tool or script 
should check the error codes, and respond as needed. For example, if the installation returns error code 
1641, then the IT tool or script should restart the computer and relaunch the installation after restart. 
This parameter is required if /QS or /Record is not specified. 

/QS Unattended Install, install runs in a quiet simple mode and shows progress through the UI, it does not 
accept any input but still shows error or restart messages. 
When using this parameter, you will not have to check the error codes, and the installation will stop and 
display a prompt if there are error or restart messages. For example, if an immediate restart is required 
to complete the install, a restart message will be displayed for you to confirm the restart. Installation 
resumes automatically from the point of interruption after restart. 
This parameter is required if /Q or /Record is not specified. 

/IAcceptAllLicenseTerms Acknowledges acceptance of the license terms. 
This parameter is required for /Q or /QS parameters. 

/AutoRestart Automatically restarts the computer after the installation is complete. Used when a restart is required to 
complete the installation. 
This parameter is optional. If this parameter is not used silent install (/Q) will return either error code 1641 
or 3010 if a restart is required, and unattended install (/QS) will result in a confirmation prompt that must 
be agreed to before the installation is completed. 

/SetupLanguage="value" Specifies which language will be displayed during install process. 
The value must be the one of the following: 
• ENU 
• CHS 
• DEU 
• ESP 
• FRA 
• ITA 
• JPN 
• KOR 
• PTB 
This parameter is optional. If this parameter is not used, the default language is the current user or 
operating system user interface language. 

/Record Records the installation options chosen to a recording file. 
This parameter is optional. 

/Playback Plays back a recording file to specify the installation options. 
This parameter is optional. 
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Parameter Description 

/IgnoreWarning Specifies that the setup ignores warnings and continues. 
This parameter is optional. If it is not specified, the setup exits when a warning occurs. 

/Product="value" Specifies which sub-products will be installed. 
The product name must be one of followings: 
• AssetCentre Server 
• AssetCentre Client 
• AssetCentre Agent 
• AssetCentre Custom Installation 

/Uninstall Uninstalls the product. 
This parameter is optional. 

/ProductLanguage="value" Specifies the language version of the software being installed.  
The value must be the one of the following: 
• ENU 
• CHS 
• DEU 
• ESP 
• FRA 
• ITA 
• JPN 
• KOR 
• PTB 
This parameter is optional. If this parameter is not used, the default language is the same as the setup 
language.  
If the software does not support multiple languages this parameter is not available. 

/SerialNumber="value" Specifies the serial number of the software being installed. This is used to activate the software during 
installation. 
This parameter is optional. If it is not specified the software must be activated manually after installation if 
activation is required.  
Some software does not require activation. If activation is not required this parameter is not available. 

/ProductKey="value" Specifies the product key used to get activation keys during installation. 
This parameter is optional. If it is not specified the software must be activated manually after installation if 
activation is required.  
Some software does not require activation. If activation is not required this parameter is not available. 

/Version="value" Specifies the version of the software to activate which corresponds to the product version associated with 
the SerialNumber and ProductKey. 
This parameter is optional. If it is not specified the installer will use the most recent product version 
available. 
Some software does not require activation. If activation is not required this parameter is not available. 

/InstallDrive="value" Specifies the install drive. 
This parameter is optional. If this parameter is not used, the default install location is "C:\Program Files 
(x86)\Rockwell Software". 
Some software restricts the installer to only change the drive the software is installed on. Use /? to 
determine which parameter is supported. 

/ftsp-value="value" Specifies the FactoryTalk security policy value. 
This parameter is optional. 
Use the enable or disable value to change the state of RequireComputerAccounts during installation. 

/noHTTPS Specifies that the setup turns off HTTPS and continues. 
This parameter is optional. 

/SqlServer="value" Specifies FactoryTalk AssetCentre database server (Microsoft SQL Server) location. 
This parameter is required when installing the FactoryTalk AssetCentre server software. 
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Parameter Description 

/MSA="value" Specifies the Group Managed Service Account (gMSA) or Managed Service Account (MSA) that will be used 
by FactoryTalk AssetCentre Server to access the Microsoft SQL Server database when using Windows 
Authentication. 
• The parameter is required when the Microsoft SQL Server is hosted on a different computer than the 

FactoryTalk AssetCentre Server. 
• The parameter is optional when the Microsoft SQL and FactoryTalk AssetCentre Servers are hosted o the 

same computer. 
/sql Uses SQL Authentication between the FactoryTalk AssetCentre and Microsoft SQL Servers. The use of SQL 

Authentication is discouraged due to security concerns. 
This parameter is optional. 

/sa="value" Uses SQL Authentication for SQL Server Logins. If you use SQL Server Authentication to perform silent or 
unattended installation, the parameters /SqlAdmin, and /SqlAdminPwd are required. 

/SqlAdmin="value" Specifies the Microsoft SQL Server administrator account name. 
/SqlAdminPwd="value" Specifies the Microsoft SQL Server administrator account password. 
/DirectoryServer="value" Specifies the FactoryTalk network directory if you are using a distributed system. 

This parameter is optional. If it is not specified, the software will use its current computer as the 
FactoryTalk Directory server. 
The value must be the host name of the FactoryTalk Directory server. 

Error codes 
The following table identifies the error codes that can be returned by an installation.  

Error Code Value Description 

ERROR_SUCCESS 0 The installation completed successfully. 
ERROR_INVALID_PARAMETER 87 One of the parameters was invalid. 
ERROR_INSTALL_USEREXIT 1602 The installation was cancelled by the user. 
ERROR_INSTALL_FAILURE 1603 A fatal error occurred during installation or the software component to be installed 

already exists on the computer. 
ERROR_BAD_CONFIGURATION 1610 The configuration data for this product is corrupt. Contact your support personnel. 
ERROR_REBOOT_CONTINUE 1641 A reboot is required to continue to installation. 

ERROR_SUCCESS_REBOOT_REQUIRED 3010 A restart is required to complete the installation. After restart the product is 
successfully installed. 

ERROR_REBOOT_PENDING 3012 A restart is pending and is required before the installation can continue. 
ERROR_SUCCESS_NOT_APPLICABLE 3013 The installation cannot proceed because the products are already installed. 

 

After the installation using the unattended setup 
You can find the installation logs and view the installation status in the following path: 

• On 32-bit operating systems: 

C:\Program Files\Common Files\Rockwell\Install Logs 

• On 64-bit operating systems: 

C:\Program Files (x86)\Common Files\Rockwell\Install Logs 

Once the installation is complete, you need to activate FactoryTalk AssetCentre. For more information, see Step 5: 
Finish the installation on page 21. 
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After the installation using the unattended setup, you can configure FactoryTalk AssetCentre. 

For details, see: 

• Configure the SSL protocol for FactoryTalk AssetCentre on page 73 
• Configure FactoryTalk AssetCentre on page 101 
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Chapter 9 

Configure the SSL protocol for FactoryTalk AssetCentre 

Using the SSL protocol is required for FactoryTalk AssetCentre Web Client and recommended for the FactoryTalk 
AssetCentre server, clients, and agents. 

IMPORTANT Using the SSL protocol is an essential part of ensuring communications security. Without 
it, no communication, including logging on to the system, is encrypted. 

The SSL configuration consists of the following steps: 

• Create an SSL certificate on page 73 
• Export the created SSL certificate for FactoryTalk AssetCentre client and agent computers on page 75 
• Configure a site binding on page 77 
• Configure SSL settings for FactoryTalk AssetCentre Web Client on page 80 
• Turn on secure communication between the server, client(s), and agent(s) on page 82 
• Import the SSL certificate to client and agent computers on page 83 
• Configure a firewall rule and web services URL if the default port is modified on page 91 

Create an SSL certificate 
In order to use the SSL protocol you need to have an SSL certificate on the FactoryTalk AssetCentre server computer. 

To create an SSL certificate 
1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer. 

On Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2: 

a. On the taskbar, click . 
b. In the search box, type inetmgr, and then press Enter. 
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c. Click the best match result. 

 
2. Under Connections, click the FactoryTalk AssetCentre server. 

 
3. In Features View, double-click Server Certificates. 

 



 

 Rockwell Automation Publication - FTAC-IN005I-EN-E - March 2021 75 
 

4. Under Actions, click Create Self-Signed Certificate. 

 
5. In the Create Self-Signed Certificate dialog box: 

• Specify a name for the certificate. 
• Select Web Hosting as the certificate store. 

 
6. Click OK. 

The created SSL certificate is listed. 

 

Export the created SSL certificate for FactoryTalk AssetCentre client and agent computers 
After creating an SSL certificate on the FactoryTalk AssetCentre server computer, export the certificate which will 
need to be imported on the FactoryTalk AssetCentre client and agent computers. 
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To export the created SSL certificate 
1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer. 

On Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2: 

a. On the taskbar, click . 
b. In the search box, type inetmgr, and then press Enter. 
c. Click the best match result. 

 
2. Under Connections, click the FactoryTalk AssetCentre server. 
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3. In Features View, double-click Server Certificates. 

 
4. Select the SSL certificate that you have created. 
5. Under Actions, click Export. 

 
6. In the Export Certificate dialog box: 

• Under Export to, click , and then specify the location and name to save the certificate. 
• Specify the password for the certificate. 

7. Click OK. 

Configure a site binding 
Before you begin 

• Create an SSL certificate on page 73. 
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To configure a site binding 
1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer. 

On Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2: 

a. On the taskbar, click . 
b. In the search box, type inetmgr, and then press Enter. 
c. Click the best match result. 

 
2. Navigate to localhost > Sites > Default Web Site. 
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3. Under Actions, click Bindings. 

 
4. In the Site Bindings dialog box, click Add. 

 
5. In the Add Site Binding dialog box, configure the following settings. 

 
For this option... Do this... 

Type Select https. 
IP address Select All Unassigned. 
Port Keep the default port number 443 or if you needed, you may change it to a 

self-defined port. 
If you use a self-defined port, you need to configure a firewall rule and web 
services URL on page 91. 

Host name Type the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre 
server. 
Tip: On Window Server 2008 R2, this option is not editable after selecting https. 

SSL certificate Select your SSL certificate. 
See Create an SSL certificate on page 73. 
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6. Click OK. 
7. In the Site Bindings dialog box, the created site binding is listed. Click Close. 

 

 
Tip: You can remove the default HTTP site binding and only keep the created HTTPS site binding. 

 

Configure SSL settings for Management of Change, FactoryTalk AssetCentre Client and 
Agent, and FactoryTalk AssetCentre Web Client 
Before you begin 

• Create an SSL certificate on page 73. 
• Configure a site binding on page 77. 

To configure SSL settings for Management of Change, FactoryTalk AssetCentre Client and Agent, and 
FactoryTalk AssetCentre Web Client 

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer. 

On Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2: 

a. On the taskbar, click . 
b. In the search box, type inetmgr, and then press Enter. 
c. Click the best match result. 

 
2. Navigate to localhost > Sites > Default Web Site. 
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To configure the SSL settings for Management of Change, select LLumin. 
To configure the SSL settings for FactoryTalk AssetCentre Client and Agent, and FactoryTalk AssetCentre 
Web Client, select AssetCentre and AssetCentreWebClient under RockwellSoftware. 

 
3. In Features View, double-click SSL Settings. 

 
4. Make sure the following options are selected: 

• Require SSL 
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(FactoryTalk AssetCentre Web Client only) Selecting this option will result in deactivating the HTTP 
protocol (with the default port 80). When you type http:// in the web browser, it will be automatically 
redirected to https://. 

• Ignore 

This option applies to the client certificates. 

 
5. Under Actions, click Apply. 

 
6. Restart the computer. 

 

 

Turn on secure communication between the server, client(s), and agent(s) 
Once you configured the SSL protocol, turn on secure communication between the server, client(s), and agent(s) in 
the Configure Server Settings Utility window. 

To enable secure communication 
1. Open the Configure Server Settings Utility window. 

On Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2: 

a. On the taskbar, click . 
b. In the search box, type Server Settings. 
c. Click Server Settings. 

2. Enter the user name and password to log on to FactoryTalk, and then click OK. 
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In the Configure Server Settings Utility window, under Server Location, the domain name (FQDN) of the 
FactoryTalk AssetCentre server computer will be detected automatically. 

 
3. Select the Use the secure communication channel option. 
4. Click OK. 

Import the SSL certificate to client and agent computers 
On the client and agent computers, add the SSL certificate to the Trusted Root Certification Authorities certificate 
store. 

Before you begin 
• Create an SSL certificate on page 73. 
• Export the created SSL certificate on page 75. 

The steps to import the SSL certificate on all the supported operating systems are the same except for Windows 7 
operating systems. 

To import the SSL certificate on operating systems except for Windows 7 
1. Copy the created SSL certificate on the computer. 
2. Double-click the SSL certificate. 
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3. Select Local Machine, and then click Next. 

 
4. When prompted to confirm the operation, click Yes. 
5. Follow the on-screen instructions until you get to the Certificate Store screen. 
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6. On the Certificate Store screen, select Place all certificates in the following store. 

 
7. Click Browse, select Trusted Root Certification Authorities, and then click OK. 
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8. Click Next. 

 
9. Follow the on-screen instructions to complete the import. 

To import the SSL certificate on Windows 7 operating systems 
1. Copy the created SSL certificate on the computer. 
2. Click Start, type mmc, and then press Enter. 

The Microsoft Management Console opens. 

3. In the Microsoft Management Console, navigate to Console Root > Certificates (Local Computer) > Trusted 
Root Certification Authorities > Certificates. 

4. Right-click Certificates, and then select All Tasks > Import. 
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5. In the Certificate Import Wizard, click Next. 

 
6. On the File to Import page, browse for the SSL certificate file, and then click Next. 

 
7. (Optional) Enter the password if it has been defined. 
8. On the Certificate Store page, make sure: 

• Place all certificates in the following store is selected. 
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• Trusted Root Certification Authorities is selected as the certificate store. 

Click Next. 

 
9. Click Finish. 

 

After the import operation, you may want to verify whether the SSL certificate is successfully imported. 
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To verify the import operation 
1. Click Start, type mmc, and then press Enter. 

The Microsoft Management Console opens. 

2. Click File > Add/Remove Snap-in. 
3. In the Add or Remove Snap-ins dialog box, select Certificates, and then click Add. 

 
4. In the Certificates snap-in dialog box, select Computer account, and then click Next. 
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5. Click Finish. 

 
6. In the Add or Remove Snap-ins dialog box, click OK. 

 
7. In the Microsoft Management Console, navigate to Console Root > Certificates (Local Computer) > Trusted 

Root Certification Authorities > Certificates, and verify that the SSL certificate is listed. 
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8. If the SSL certificate is not listed, make sure to select Certificates under Trusted Root Certification 
Authorities > Certificates, and then click Action > All Tasks > Import. 

9. Follow the on-screen instructions to complete the import. 

Configure a firewall rule and web services URL if the default port is modified 
If the default port 443 is modified during the site binding configuration, you need to: 

• Configure a Windows firewall rule for the self-defined port. 
• Configure the primary server web services base URL. 

To configure a Windows firewall rule 
1. On the FactoryTalk AssetCentre server computer, click Start, type firewall, and then click Windows Firewall 

with Advanced Security. 
2. Click Inbound Rules. 

 
3. Click Action > New Rule. 
4. In the New Inbound Rule Wizard, select Port, and then click Next. 
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5. In the Specific local ports box, enter the self-defined port as set during the site binding configuration, for 
example 9000, and then click Next. 

 
6. Follow the on-screen instructions until you get to the Name page. 
7. In the Name box, enter the name for the new inbound rule, and then click Finish. 
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The new rule is shown in the list. 

 

To configure the primary server web services base URL 
1. On the FactoryTalk AssetCentre server computer, click Start > All Programs > Rockwell Software > 

FactoryTalk Administration Console. 
2. In the Explorer, navigate to Network > System > Policies > Product Policies > FactoryTalk AssetCentre, and 

then double-click Server Settings. 
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3. In the Server Settings Properties dialog box, click the Primary Server Web Services Base URL box, and then 
change the computer name part in the form as MYSERVER:PortNumber. 

 
4. Click OK. 

Manage TLS Protocol 
In FactoryTalk AssetCentre version 11.00.00, it is required to use TLS 1.1 and TLS 1.2 or later for the communication 
security over your network. You can manage TLS Protocol through modifying the registry keys located in the 
following location 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols. To configure the 
TLS certificate, you can follow the configuration steps of SSL certificate. 

IMPORTANT If you want to configure the protocols as needed, you should use the same protocol for all 
computers deployed in your network. 
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To turn on the Client of TLS 1.1 and TLS 1.2 
1. Press Window + R. 
2. In the Run dialog box, enter regedit, and then select OK. 
3. In the Registry Editor window, go to Protocols. Then you can create the necessary subkeys for TLS 1.1, create 

the Client subkey, and create the DisabledByDefault DWORD value. 
4. Double-click DisabledByDefault to open the Edit DWORD Value dialog box. 
5. In the Value data box, enter 0 and then select OK to save the changes. 

 
Note: You can repeat the above steps to create the subkey for TLS 1.2, the Client subkey, 
DisabledByDefault value, and set DisabledByDefault to 0. 

To turn off the Client of TLS 1.0 
1. Press Window + R. 
2. In the Run dialog box, enter regedit, and then select OK. 
3. In the Registry Editor window, go to Protocols > TLS 1.0 > Client as the above picture. 
4. Double-click Enabled to open the Edit DWORD Value dialog box. 
5. In the Value data box, enter 0 and then select OK to save the changes. 
6. Double-click DisabledByDefault to open the Edit DWORD Value dialog box. 
7. In the Value data box, enter 1 and then select OK to save the changes. 
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Chapter 10 

Configure Windows Authentication 

Windows Authentication is a secure way of authentication that uses the username and the password of the user 
logged on to the operating system. In the communication secured with Windows Authentication mode, the 
username and the password are sent between the client and the server in a strongly hashed form. 

Windows Authentication may be enabled in corporate networks that use Microsoft Active Directory services as well 
as other ways to identify users. 

By turning on Windows Authentication mode you increase the security of the communication between the 
FactoryTalk AssetCentre server, client(s) and agent(s) and prevent unauthorized users from accessing the 
FactoryTalk AssetCentre server. 

Important: For the purposes of FactoryTalk AssetCentre, Windows Authentication 
mode should be enabled only in corporate networks that use Microsoft 
Active Directory services. 

After you turn on Windows Authentication mode, the access to the page: 

http(s)://assetcentre_server_full_name/rockwellsoftware/assetcentre 

...will be secured from being accessed by anonymous users. 

In order to access the page, the users will need to log on using their Windows username and password. 

This chapter describes: 

• Turn on Windows Authentication mode in Internet Information Services (IIS) on page 97 

Turn on Windows Authentication mode in Internet Information Services (IIS) 
To turn on Windows Authentication mode in Internet Information Services (IIS) 

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer. 

On Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2: 

a. On the taskbar, click . 
b. In the search box, type inetmgr, and then press Enter. 



 

98 Rockwell Automation Publication - FTAC-IN005I-EN-E - March 2021  
 

c. Click the best match result. 

 
2. Under Connections, expand the tree, and then click AssetCentre. 

 
3. In Features View, double-click Authentication. 
4. Under Authentication, click Windows Authentication. 
5. Under Actions, click Providers. 

The Providers dialog box appears. 
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6. Make sure that you have the following providers selected in the order presented in the figure below. 

 
If these providers are not listed, select each of them in the list under Available Providers, and then click Add. 

7. Make sure that all other authentication modes listed in the pane under Authentication are disabled. 

 
 





 

 Rockwell Automation Publication - FTAC-IN005I-EN-E - March 2021 101 
 

Chapter 11 

Configure FactoryTalk AssetCentre 

This chapter describes: 

• Configure for client access to the server on page 101 
• Configure feature security for FactoryTalk AssetCentre users on page 103 

Configure for client access to the server 
For clients to be able to access the FactoryTalk AssetCentre server, the FactoryTalk Directory and FactoryTalk 
Security must be configured to give clients access. To configure access, you will need to use the FactoryTalk 
Administration Console. 

The FactoryTalk Directory uses two factors to determine who should have access to any given function: 

• The user's account, which can either be a FactoryTalk Directory account or a Windows domain account. This 
identifies the user. 

• The computer from which the user is accessing the FactoryTalk Directory. 

This allows you to limit which computers can access the directory, and also allows you to determine whether 
certain functions can or cannot be performed from a given computer. For example, you can configure the 
FactoryTalk Directory to give access to a user from her or his own computer but not from another computer. 

At a minimum, you must add the FactoryTalk AssetCentre users and their computers to the FactoryTalk Directory, 
and you must configure access privileges for FactoryTalk AssetCentre in the FactoryTalk Directory. 

Add users to the FactoryTalk Directory 
A user must have a FactoryTalk Directory user account in order to use FactoryTalk AssetCentre. 

Tip: This section contains only basic instructions for using the FactoryTalk 
Directory and FactoryTalk Security. For background information and 
information regarding more advanced procedures, please see the Help for the 
FactoryTalk Administration Console. 

By default, all members of the Administrators group on the computers on which you installed the FactoryTalk 
Services Platform were added to the Administrators group in the FactoryTalk Directory. Also, any rights that you 
assign to a Windows User Group are assigned to all members of that group.  

It is recommended to use a native FactoryTalk Group to which Windows AD user accounts and groups are added. 
This practice simplifies the process of confirming the security configuration as testing is performed on the native 
FactoryTalk Group, and policy is written about which Windows user and groups are added to the native FactoryTalk 
group. 
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To add a user to the FactoryTalk Directory 
1. Start the FactoryTalk Administration Console: 

a. Click Start, and then use search to search for FactoryTalk Administration Console. 

b. Click FactoryTalk Administration Console. 

FactoryTalk Administration Console appears. 

2. Log on to the Network directory using a FactoryTalk Administrator account. 
3. Open the Users and Groups folder. 
4. Under the Users and Groups folder, right-click the Users folder, and then select New. 
5. Specify whether you want to create a new FactoryTalk User or a Windows-Linked User. 

• FactoryTalk user accounts are visible only to the FactoryTalk system and their access is independent of 
Windows. 

• A Windows-linked user is validated by Windows domain. 

A FactoryTalk Security account is the same as a FactoryTalk user account. For more information, see 
"Accounts and groups" in the FactoryTalk Help. 

• If you may need to use FactoryTalk AssetCentre while disconnected from the network, use FactoryTalk 
Security user accounts. Windows-linked user accounts will not be able to authenticate with the domain 
while disconnected. 

• If you choose to use Windows-linked users, consider using Windows-linked group accounts rather than 
Windows-linked user accounts if possible. This simplifies the process if you ever move your software to a 
different domain. You cannot move individual Windows-linked user accounts from one domain to 
another. You can move Windows-linked group accounts to a new domain, while retaining all of the 
security permissions for the group. If you change the domain an individual Windows-linked user account 
belongs to, you must delete the old account, create the new account, and then recreate all of the security 
permissions for the new account. 
Tip: If you have users who need similar access to features of FactoryTalk 

AssetCentre, consider grouping users to make assigning security privileges 
easier. For example, you can group all of your electricians into an Electricians 
group, and then provide security access for them as a group. For information 
about grouping users, see the Help for the FactoryTalk Administration Console. 

6. Enter the information for the user. 

Add computers to the FactoryTalk Directory 
When FactoryTalk Services Platform is installed on a computer, that computer is automatically added to the 
FactoryTalk Network Directory. Because FactoryTalk Services Platform is included in the FactoryTalk AssetCentre 
installation, your client computers should already be in the FactoryTalk Network Directory. 

By default, for a user to be able to use FactoryTalk AssetCentre, the user's computer must be in the FactoryTalk 
Directory. For instructions on how to add a computer, refer to the FactoryTalk Help in the FactoryTalk 
Administration Console. 
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Tip: If you have a significant number of computers for which you need to permit or restrict access, 
consider grouping them to make assigning security privileges easier. For example, you can group all of 
the computers used in offices away from the plant floor and restrict access to features that should be 
used only from computers stationed where the user can see the automation system directly. For 
information about grouping computers, see the Help for the FactoryTalk Administration Console. 

 

Configure feature security for FactoryTalk AssetCentre users 
By default, all users and the Administrators group in FactoryTalk Directory can perform any task in the FactoryTalk 
AssetCentre software. To deny specific users the right to perform tasks in FactoryTalk AssetCentre, you must edit 
the Feature Security settings in the FactoryTalk Administration Console. 

IMPORTANT Never explicitly deny rights to the All Users or Administrators group in FactoryTalk. Rather, 
set up specific user groups of your own and deny rights to those groups. Denying rights 
to All Users or Administrators could lock everyone out of the system and would deny 
rights in all FactoryTalk-enabled products using any FactoryTalk CPR 9 version. 

To change which users can perform tasks in FactoryTalk AssetCentre 
1. Start the FactoryTalk Administration Console: 

a. Click Start, and then use search to search for FactoryTalk Administration Console. 

b. Click FactoryTalk Administration Console. 

FactoryTalk Administration Console appears. 

2. Log on to the Network directory using a FactoryTalk Administrator account. 
3. In the Explorer pane of the FactoryTalk Administration Console, navigate to System > Policies > Product 

Policies > FactoryTalk AssetCentre. 
4. Double-click Feature Security. 

IMPORTANT here is also a Server Settings object in the FactoryTalk AssetCentre folder. Do NOT 
attempt to change any of the settings in this object. Doing so may render your 
FactoryTalk AssetCentre system inoperative. If you need to change server settings 
(to use a different mail server, for example), from Windows Start menu, select 
All Programs > Rockwell Software > FactoryTalk AssetCentre Server > 
Server Settings. 

5. In the Feature Security Properties window, click the policy you want to change, and then click the browse 
button for the policy. 
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See Policy settings and their meanings on page 104. 

 
6. In the Configure Securable Action dialog box, select the user or group for whom you want to assign 

permissions. If the user or group does not appear in the list, click Add, click Show all, select the user or 
group, and then click OK. 

7. Click the appropriate box to allow or deny the user permission to the selected feature. 
8. Click OK. 

Policy settings and their functions 
The following table shows the policy settings and their functions. 

This policy setting Controls whether users can 

View Address Book View the Address Book (which contains addresses for the purpose of sending automatic e-mail notifications). 
Edit Address Book Edit or add contacts and groups in the Address Book (which contains addresses for the purpose of sending automatic e-

mail notifications). 
Override Archive Check In Check in a file regardless of who checked it out or from where it was checked out. 
Configure Database Limitations Configure the total maximum size of the AssetCentre database, the size warning levels, the maximum number of versions 

per archive asset, the maximum size of Event, Audit, and Diagnostics logs, and the database capacity status refresh rate. 

Configure Archive Options Settings Turn on or off the function that allows Logix Designer to perform archive activities, such as file check-in, without direct 
interaction with the FactoryTalk AssetCentre client. 

Clear the Get Writable Copy check box by 
default 

Enable or clear the Get Writable Copy check box during get. Denying this permission enables the Get Writable Copy check 
box; a Get retrieves a writable copy of an Archive object. Allowing this permission (by default) clears the Get Writable Copy 
check box; a Get retrieves a read-only copy of an Archive object. 

Override Archive Undo Check Out Undo a check out even if a different user checked the file out. 
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Override Removal of Local Copies Choose to keep local copies of checked-in files on their computer. If this right is allowed, the user can keep local copies. If 
this right is denied, the user is not given this option. 

Configure Personal Archive File Associations Configure which software product launches when opening a particular type of file. If a personal file association is set, it will 
take precedence over the system file association. 

Configure System Archive File Associations Configure which software product launches when opening a particular type of file. This setting applies unless the user has 
specified a personal file association. 

Configure Personal Archive Working Folders Set a personal working folder for checking out files. 
Configure System Archive Working Folders Set the system working folder to which all users check out files unless they have a personal working folder. 
Run Archive Database Cleanup Wizard Run the Archive Database Cleanup Wizard to delete unused versions of files. 
Allow Empty Comment at Check In Leave the comment field empty as they check in an asset. 

Store latest version only Choose to store only the latest version in the Archive. 
Set maximum versions Configure the total maximum number of versions stored in the Archive. 
Configure Asset Inventory Settings Configure the settings in the Asset Inventory window. 
Configure Assets Lifecycle Sync Synchronize life cycle information in the FactoryTalk AssetCentre server and client with the Rockwell Automation life cycle 

website. 
Display Calibration Management Data* View Calibration Management data in FactoryTalk AssetCentre. 
Perform Calibration Management* Access Calibration Management functionality in ProCalV5 software. 
Administer Calibration Users* Administer users, groups, and permissions in ProCalV5 software. Note that this policy only determines if the user is 

automatically added to the Administrator group in the ProCalV5 software. Once the user is added to ProCalV5, changing this 
policy for an AssetCentre user does not change the user's ProCalV5 security permissions. 

Configure Database Maintenance Configure automatic database maintenance, manually analyze, or rebuild index fragmentation. 
Switch to Design mode Enter Design mode, in which the user can edit the asset tree. 
View Event Log Show the Event Log and run a search on the Event Log. 
View Audit Log Show the Audit Log and run a search on the Audit Log. 
View Diagnostics and Health Log Show the Diagnostics and Health Log and run a search on the Diagnostics and Health Log. 
Change Diagnostics and Health Log 
Message 

Change the status of or add a comment to a Diagnostics and Health Log record. 

View Diagnostics and Health Log Status View a status history for a Diagnostics and Health Log record. 
Run Log Database Cleanup Wizard Run the Log Database Cleanup Wizard to remove old records from the logs. Data can be exported and saved in a separate 

file. 
Enable or Disable DTMs* Enable and disable DTMs in the DTM Catalog. 
Edit DTM Network* Show the DTM Networks dialog box to edit the DTM network. 
Run PDC Field Edition* Use the Process Device Configuration Field Edition software. 
Create a new schedule Create a schedule. 
Edit a schedule Change existing schedules. 
Delete a schedule Delete schedules. 
View a schedule Show the Schedules tab. 
Command a schedule Issue commands to a schedule, such as making the schedule active or running the schedule immediately. 
Create a search Set up a new search to find entries matching specified criteria in one of the logs, in the Archive History, or in Archive Check 

Out Status information. 

* Starting from FactoryTalk AssetCentre version 10.00, process device capabilities are not supported. The policies 
marked with asterisk are only kept for viewing purposes if you have upgraded FactoryTalk AssetCentre from version 
9.00 or earlier. 

 

 

 

https://www.rockwellautomation.com/global/solutions-services/capabilities/migration-solutions/product-search/overview.page
https://www.rockwellautomation.com/global/solutions-services/capabilities/migration-solutions/product-search/overview.page
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Chapter 12 

About FactoryTalk AssetCentre Web Client 

FactoryTalk AssetCentre supports the accessing of a FactoryTalk AssetCentre client through a web interface on 
computers and mobile devices. FactoryTalk AssetCentre Web Client supports several FactoryTalk AssetCentre client 
functions. The new capability allows you to: 

• View archives and schedules in the asset tree 
• View, run, and stop schedules 
• View dashboards of the Backup and Backup and Compare schedule results 
• View Event Log, Audit Log, and Diagnostics and Health Log 
• View and run searches 
• View agent groups 

It is required that you use the SSL protocol with FactoryTalk AssetCentre Mobile Client. See Configure the SSL 
protocol for FactoryTalk AssetCentre on page 73. 

Access FactoryTalk AssetCentre Web Client 
To access FactoryTalk AssetCentre Web Client 

1. Open the device's browser, and type the following address: 
https://FQDN/RockwellSoftware/AssetCentreWebClient 
Tip: FQDN is the fully qualified domain name (FQDN) of the FactoryTalk 

AssetCentre Server computer. 
If you are changed the default port in site binding on page 77, you need to 
include the self-defined port number in the computer name part in the form 
as MYSERVER:PortNumber. 

2. On the FactoryTalk AssetCentre Web Client page, type the user name and the password. 
Tip: Make sure to create a FactoryTalk Service Platform account and its password 

on the computer running FactoryTalk AssetCentre server. The account and 
password are used to log on to FactoryTalk AssetCentre Web Client. 

3. Tap or click Log in. 
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Chapter 13 

Uninstall FactoryTalk AssetCentre 

Uninstall FactoryTalk AssetCentre software version 8.00 or later from Programs and Features in Windows Control 
Panel or using a command. 

• Uninstall from the Control Panel on page 109 
• Uninstall using a command on page 109 

 
Tip: To uninstall FactoryTalk AssetCentre version 7.10 or earlier, use Windows Control Panel. 

 

Uninstall from the Control Panel 
To uninstall FactoryTalk AssetCentre from the Control Panel 

1. Depending on how the software component was installed with the Setup wizard, the uninstallation varies. 

• If only installed with AssetCentre Server, double-click FactoryTalk AssetCentre Server 11.00.00. 
• If only installed with AssetCentre Agent, double-click FactoryTalk AssetCentre Agent 11.00.00. 
• If only installed with AssetCentre Client, double-click FactoryTalk AssetCentre Client 11.00.00. 
• If installed with AssetCentre Custom Installation, double-click FactoryTalk AssetCentre 11.00.00. 

2. Click Uninstall. 
3. Click Close or restart the computer. 

Uninstall using a command 
When uninstalling with a command, it uninstalls components that are already installed with the product specified. 
It does not uninstall components, such as FactoryTalk Activation Manager, that are shared with other products. You 
need to manually uninstall them in Control Panel. 

To uninstall FactoryTalk AssetCentre using a command 
1. Close all Windows programs. 
2. Open the Command Prompt window. 
3. In the Command Prompt window, navigate to D:, where D: is the drive containing the FactoryTalk View 

installation package. 

In this example, type D: and press Enter. 

 
Tip: If User Account Control dialog box shows, click Yes. 

4. Type a command with the following syntax and press Enter. 
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Setup.exe /Q /Uninstall /Product=product_name 

For example, to uninstall FactoryTalk AssetCentre client, use the following command: 
Setup.exe /Q /Uninstall /Product="AssetCentre Client" 

The following table shows command-line parameters for this mode: 

Parameter Description 

/Q Required if /QS is not specified. 
Uninstalls the product in the silent mode without any user interface during uninstallation. 

/QS Required if /Q is not specified. 
Uninstalls the product in the unattended mode during uninstallation, and shows the progress, errors, or complete 
messages on the user interface. 

/Uninstall Required. 
Uninstalls components that are already installed with the product specified. 

/Product=product_name Required. 
Specifies which product will be uninstalled. 
The parameter value must be the one of following: 
• AssetCentre Server 
• AssetCentre Client 
• AssetCentre Agent 
• AssetCentre Custom Installation 
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Chapter 14 

Troubleshoot FactoryTalk AssetCentre 

This chapter describes: 

• General installation on page 111 
• Server installation on page 111 
• Client and agent installation on page 112 
• Start the client on page 113 
• Start the agent on page 119 

General installation 

A red x appears next to an item to be installed 
The initial window in each installation (server, client, and agent) shows a list of all necessary components, whether 
they were found on the computer, and whether they will be installed. If the installer could not determine whether 
the correct version already exists on that computer, a red x is shown next to a component . 

Contact Technical Support using the contact information provided on the copyright page at the beginning of this 
guide. 

A Program Maintenance window appears 
This indicates that the component of the software you are installing is already installed. You do not need to install it 
again. If you suspect your installation is damaged, you can choose to repair the installation. 

Server installation 

SQL collation error encountered during database installation 
The SQL Server collation must be case-insensitive for use with FactoryTalk AssetCentre software. If your SQL Server 
collation is case-sensitive, the FactoryTalk AssetCentre database installation will fail. If your SQL Server collation is 
case-sensitive, see Install Microsoft SQL Server on page 16 for detailed directions. 

Unable to log on to SQL Server during server installation 
In FactoryTalk AssetCentre Server version 10.00.00 and later, SQL Server sa (system administrator) account is only 
available for silent or unattended installation. 
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• If you configured your SQL Server to use mixed (both SQL Server and Windows domain) authentication, the 
sa account is available. Use the password you created for the sa account when the installation program 
prompts you for it. 

• If your SQL Server installation is not configured for mixed authentication, you will need to change the 
authentication method. See the documentation for SQL Server for more information. 

 
Tip: New installations of FactoryTalk AssetCentre Server installation require that the Windows 
account of the user performing the installation, or a Windows group of which the user 
performing the installation is a member, is assigned the Microsoft SQL Server System 
Administrator role before attempting the installation. This change is optional for Upgrade 
installations. 

• If you have forgotten your sa account password, you will need to change it. See the Microsoft SQL Server 
documentation for more information. 

The application failed to initialize properly 
This is a known issue with Symantec Endpoint Protection. When installing the FactoryTalk AssetCentre server on a 
computer that has Symantec Endpoint Protection version 11.0.5002.333, you may receive an error message 
indicating that the application you are installing fails to initialize properly. 

To fix this issue 
• Use a different Symantec Endpoint Protection version. 
• Disable the Symantec Application and Device Controller service by following the steps below: 

a. From Windows Start menu, select All Programs > Accessories > Command Prompt. 

b. In the Command Prompt window, enter sc config sysplant start=disabled and press Enter. 

c. Restart the computer and try to install the server again. 

Client and agent installation 

Web page for installing the FactoryTalk AssetCentre client and agent cannot be shown 
To solve this problem 

• Make sure the FactoryTalk AssetCentre server computer is running. In the Windows Services utility, make 
sure that the FactoryTalk AssetCentre Server service is running. 

• Make sure you have access to your local area network. 
• Make sure you are installing the software as an administrator, or an account with administrative privileges. 
• Make sure IIS is running on the server computer. 
• Try logging on to the server computer from the client. On the client computer, click Start, then select Run. In 

the Open field type two backslashes, and then the server name (for example, \\ourserver). Click OK. You will be 
asked to log in to the server. 

• If you are using a firewall, make sure File and Printer Sharing is permitted through the firewall. Port 80 (or 
whatever port used for HTTP on the server machine) also needs to be permitted. 
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To make sure IIS is running on the server computer 
1. On supported operating systems (Windows Server 2019, 2016, and 2012 R2) of FactoryTalk AssetCentre 

Server, click Start. 
2. On the Start menu, right-click My Computer, and then click Manage. 

Server Manager appears. 

3. In the Server Manager tree, expand Roles. 
4. Under Roles, expand Web Server (IIS). 
5. Under Web Server (IIS), click Internet Information Services (IIS) Manager. 
6. In the right pane, under Connections, expand the server node. 
7. Expand Sites, and then click Default Web Site. 
8. In the right pane, under Actions, check if the site is running. 

If it is not, start it: 

• In the right pane, under Manage Web Site, click Start. 

Error reading Primary Server Name from FactoryTalk Directory 
This error occurs when the computer on which you are installing the client is not using the same FactoryTalk 
Directory as the computer running the FactoryTalk AssetCentre server, or there was an error in the FactoryTalk 
Services Platform. 

To solve this problem 
1. On the FactoryTalk AssetCentre server computer, set the FactoryTalk Directory location. 

From Windows Start menu, select All Programs > Rockwell Software > FactoryTalk Tools > Specify 
FactoryTalk Directory Location. 

2. Log in if prompted to do so, and then specify the location of the FactoryTalk Directory. 
3. Close any clients that are connected to the server. 
4. Restart the FactoryTalk Directory Server. 

Logged in user is not part of the Administrators group 
Currently logged in Windows user is not part of the Administrators group. 

To resolve this problem, make sure you are installing the software as an administrator, or a user with administrative 
privileges. 

Start the client 

Error initializing FactoryTalk AssetCentre 
The FactoryTalk AssetCentre server may have failed (or you may have lost your network connection to the server), or 
the computer on which you installed the client may not be part of the FactoryTalk Directory. 
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To solve the problem 
• Check the server (see Other errors starting the client on page 119). 
• Try adding the client computer to the FactoryTalk Network Directory. From another computer that has 

access to the FactoryTalk Directory (the FactoryTalk AssetCentre server, for example), use the FactoryTalk 
Administration Console to add the computer to the FactoryTalk Directory. See Add computers to the 
FactoryTalk Directory on page 102. 

• See If the FactoryTalk AssetCentre server is installed to a drive other than C on page 118. 

Error initializing FactoryTalk AssetCentre: unable to connect to the remote server 
When starting the FactoryTalk AssetCentre client, you may get the following error: 

 

The error message may appear when you have checked the Use the secure communication channel option in the 
Configure Server Settings Utility window, but you haven't configured the SSL protocol. 

To solve the problem 
• Configure the SSL protocol. 

See Configure the SSL protocol for FactoryTalk AssetCentre on page 73. 

• Clear the Use the secure communication channel check box in the Configure Server Settings Utility window, 
if you don't want to use the SSL protocol. 
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Error initializing FactoryTalk AssetCentre: the underlying connection was closed 
When starting the FactoryTalk AssetCentre client, you may get the following error: 

 

The error message may appear in the following cases: 

• You have provided an incomplete fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server 
computer in the Configure Server Settings Utility window for the SSL configuration. 

• You haven't added the certificate authority that issued the SSL certificate to the Trusted Root Certification 
Authorities certificate store for the SSL configuration. 

To solve the problem 
• Make sure that the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in 

the Configure Server Settings Utility window is complete. 

See Turn on secure communication between the server, client(s) and agent(s) on page 82. 

• Add the certificate authority that issued the SSL certificate to the Trusted Root Certification Authorities 
certificate store for the SSL configuration. 

• See Import the SSL certificate to client and agent computers on page 83. 



 

116 Rockwell Automation Publication - FTAC-IN005I-EN-E - March 2021  
 

Error initializing FactoryTalk AssetCentre: the remote server returned error (404) Not 
Found 
When starting the FactoryTalk AssetCentre client, you may get the following error: 

 

The error message may appear when you have misspelled the fully qualified domain name (FQDN) of the 
FactoryTalk AssetCentre server computer in the site binding for the SSL configuration in the Internet Information 
Services (IIS) Manager. 

To solve the problem 
• Correct the spelling of the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server 

computer in the site binding. 

See Configure a site binding on page 77. 

Error initializing FactoryTalk AssetCentre: the remote name could not be resolved 
When starting the FactoryTalk AssetCentre client, you may get the following error: 

 

The error message may appear when you have misspelled the fully qualified domain name (FQDN) of the 
FactoryTalk AssetCentre server computer in the Configure Server Settings Utility window for the SSL configuration. 
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To solve the problem 
• Correct the spelling of the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server 

computer in the Configure Server Settings Utility window. 

See Turn on secure communication between the server, client(s) and agent(s) on page 82 

Error initializing FactoryTalk AssetCentre: the remote server returned an error (401) 
Unauthorized 
When starting the FactoryTalk AssetCentre client, you may get the following error: 

 

The error message may appear when you have enabled Windows Authentication for FactoryTalk AssetCentre 
computers that are not added to a Microsoft Active Directory, and the local account with which you are starting the 
client doesn't exist on the remote FactoryTalk AssetCentre server computer to which the client is trying to connect. 

To solve the problem 
• On the remote FactoryTalk AssetCentre server computer, add an account that has the username and the 

password identical with the local account credentials that were used to start the FactoryTalk AssetCentre 
client. 

See Configure Windows Authentication on page 97 

The client and server versions are incompatible 
The FactoryTalk AssetCentre software installed on the server has been updated, and the software on the client needs 
to be updated. See Check whether the client is installed correctly on page 34. 

Cannot initialize application eventing subsystem or No connection could be made because 
the target machine actively refused it 
If you see the error Cannot initialize application eventing subsystem, or an error indicating that the target machine 
actively refused the connection, then: 
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• Make sure the FactoryTalk AssetCentre Server service is started on the server computer. 
• Restart the client computer. 
• If you still see the error, stop and disable all schedules. Restart the FactoryTalk AssetCentre server computer. 

IMPORTANT While the server is restarting other users will not be able to edit the asset tree, 
create or edit schedules and searches, view information in the logs, and so on. 
Also, most data will not be logged during the reboot. The exception is audit data 
generated by other software products such as RSLogix software, which is cached 
and will appear in the audit log when the server comes back online. 

• See If the FactoryTalk AssetCentre server is installed to a drive other than C: on page 118. 

At least one service or driver failed during system startup. Use Event Viewer to examine the 
event log for details 
This message may appear when launching RSLinx Classic on a system that has both RSLinx Classic and FactoryTalk 
Linx, formerly known as RSLinx Enterprise, installed. The System Event log contains the message, The A-B Virtual 
Backplane service failed to start due to the following error: The system cannot find the file specified. 

In some cases, the Virtual Backplane driver does not get installed correctly. For more information, see the 
Knowledgebase Document ID: BF16472 - AB Virtual Backplane Failed to Start Message. 

If the FactoryTalk AssetCentre server is installed to a drive other than C: 
If the server was installed to a drive other than C:, and necessary permissions to the Users group were removed on 
that drive, you may encounter error messages when starting the client. The FactoryTalk AssetCentre Server service 
will be stopped and, if you attempt to manually start it, will fail to start. 

To rectify this problem, you must set permissions for the Users group on that drive as follows: 

1. On the server computer in Windows Explorer, or My Computer, navigate to the Program Files folder on the 
drive, on which the FactoryTalk AssetCentre server was installed. 

2. Right-click the Rockwell Software folder and select Properties. 
3. Select the Security tab. 
4. Add the group Users (computername\Users) if it is not in the list. If it is in the list, skip to step 5. 

To add the Users group: 

a. Click Add. 

b. Make sure the local computer name appears in the From this location field. 

c. In the Enter the object names to select field, type: 

Users 

d. Click Check Names, then OK. 

5. Select the group Users (computername\Users).  
6. Set the Read & Execute, List Folder Contents, and Read permissions to Allow. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/34128
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Other errors starting the client 
If the client won't start or you see other error messages not specifically mentioned above, try the following: 

• Make sure the client computer is connected to the network, and the network is operational. 
• Make sure the FactoryTalk AssetCentre server computer is running. 
• Make sure the FactoryTalk AssetCentre Server service, IIS, and SQL Server are all running on the server 

computer (and the database computer if separate). To check IIS, see To make sure IIS is running on the 
server computer on page 112. 

• Make sure the correct FactoryTalk Directory is specified. On the machine running the client, from Windows 
Start menu, select All Programs > Rockwell Software > FactoryTalk Tools > Specify FactoryTalk Directory 
Location. 

• If you are running in an environment without a domain controller (in a workgroup), you may need to turn 
off the single sign-on feature of FactoryTalk. See the FactoryTalk Help for more information. 

• Make sure the server location setting is correct. On the server computer, from Windows Start menu, select 
All Programs > Rockwell Software > FactoryTalk AssetCentre Server > Server Settings. The server location 
must be set in this utility, NOT in the FactoryTalk Administration Console. 

• Make sure the SQL Connection is set properly. On the server computer, from Windows Start menu, select All 
Programs > Rockwell Software > FactoryTalk AssetCentre Server > Data Source Configuration. 

• If you are using a firewall, make sure your firewall is configured properly to permit access to the FactoryTalk 
AssetCentre Server. See Network requirements on page 13, and Knowledgebase Document ID: BF7490 - 
TCP/UDP Ports Used by Rockwell Automation Products. 

Start the agent 
If the FactoryTalk AssetCentre software installed on the server has been updated, the agent will not start until the 
software on the agent is updated. See Check whether the agent software is current on page 30. 

 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/898270
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/898270
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Legal Notices 

Legal Notices 
Rockwell Automation publishes legal notices, such as privacy policies, license agreements, trademark disclosures, 
and other terms and conditions on the Legal Notices page of the Rockwell Automation website. 

End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement (EULA) by opening the license.rtf file located in 
your product's install folder on your hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf. 

Open Source Software Licenses 
The software included in this product contains copyrighted software that is licensed under one or more open source 
licenses.  

You can view a full list of all open source software used in this product and their corresponding licenses by opening 
the index.html file located your product's OPENSOURCE folder on your hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\FactoryTalk AssetCentre\Release 
Notes\OPENSOURCE\index.htm 

You may obtain Corresponding Source code for open source packages included in this product from their respective 
project web site(s). Alternatively, you may obtain complete Corresponding Source code by contacting Rockwell 
Automation via the Contact form on the Rockwell Automation website: 
http://www.rockwellautomation.com/global/about-us/contact/contact.page. Please include "Open Source" as part of 
the request text. 

 

 

 

https://www.rockwellautomation.com/global/legal-notices/overview.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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Rockwell Automation support 
Use these resources to access support information. 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and find 
associated firmware. 

rok.auto/pcdc 

 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

 
At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec
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